Contents

Introduction ......................................................................................... 1
Manual conventions .............................................................................. 2
Questions or concerns ........................................................................... 2
Applications ......................................................................................... 2
Capabilities ......................................................................................... 3
Software ............................................................................................... 3
  Optional modules and software .......................................................... 3
Hardware ............................................................................................... 4
  Microscope and x-ray detectors ...................................................... 4
  Ethernet support .............................................................................. 4
  Acquisition chassis ........................................................................... 5

Getting Started ................................................................................... 6
Before you use the system ................................................................. 6
Starting the software ........................................................................... 6
The NSS window ................................................................................ 7
  Window panes .................................................................................. 7
    Navigation pane ............................................................................ 8
    File name and file list panes .......................................................... 8
    Analysis control panes .................................................................. 8
    Spectrum pane ............................................................................... 9
  Working from the toolbars .............................................................. 9
    NSS toolbar .................................................................................. 9
    Acquisition toolbar ....................................................................... 10
    Spectrum toolbar .......................................................................... 10
    Ident toolbar ............................................................................... 11
    Elements toolbar ......................................................................... 11
    Detector Selector toolbar ............................................................. 11
Defining a project ................................................................................ 12
  Acquisition properties ..................................................................... 12
  Microscope parameters .................................................................... 13

Acquiring and Managing Data ............................................................ 14
Acquiring images and spectra ........................................................... 14
Viewing the spectrum ........................................................................ 15
  Expanding the spectrum .................................................................. 16
  Compressing a spectrum .................................................................. 16
  Scrolling through a spectrum ......................................................... 16
  Zooming in on a peak ..................................................................... 17
  Displaying the full spectrum ........................................................... 17
  Applying a log scale ........................................................................ 17
Managing files ........................................................................................................... 17
Project Explorer ....................................................................................................... 18
Opening and saving files .......................................................................................... 18
Labeling a data set .................................................................................................... 19
Renaming a file .......................................................................................................... 20
Adding note text ....................................................................................................... 20

Spectrum Mode .......................................................................................................... 21
Setting spectral acquisition properties .................................................................... 22
Comparing spectra ..................................................................................................... 25
SpectraCheck ............................................................................................................. 27
Performing math operations on spectra with Spectrum Math software ................. 28
  Naming the result file .............................................................................................. 28
  Selection of files to process .................................................................................... 29
  Selection of the math operation to perform ............................................................ 30
  The operand type ..................................................................................................... 31
  Processing the selected spectra ............................................................................. 31
  Resetting the dialog ............................................................................................... 32
  The right click menu ............................................................................................... 32
  Ending the dialog .................................................................................................... 32
Performing math operations on regions of interest ................................................... 33

Preparing for an Analysis ........................................................................................ 35
Selecting elements for analysis .............................................................................. 35
  Highlighting elements for analysis ....................................................................... 36
    Automatic selection ............................................................................................... 36
    Manual selection .................................................................................................. 36
Setting advanced element parameters .................................................................... 37
Specifying lines for quantification and display ......................................................... 38
Excluding elements from quantitative results only ................................................. 39
Excluding elements from peak identification analysis .............................................. 39
Clearing identification results .................................................................................. 39
Viewing the history periodic table .......................................................................... 40
Specifying identification sensitivity ......................................................................... 40
Setting processing parameters ................................................................................ 41

Identifying Peaks Manually ..................................................................................... 43
Locating possible elements ....................................................................................... 43
  Viewing KLM lines ................................................................................................. 43
  Scrolling KLM lines with keyboard arrow keys .................................................... 44
  Scrolling for KLM lines on the spectrum ............................................................... 45
Finding possible elements at a peak ......................................................................... 46
Customizing x-ray line energies and intensities ....................................................... 46
Labeling peaks ......................................................................................................... 48
  Labeling all peaks ................................................................................................ 48
  Editing the label for a specific peak ...................................................................... 48
Adding peak ID labels for a specific element ........................................ 49
Removing peak labels ........................................................................... 49
Searching for KLM lines and adding labels .......................................... 50
Changing the appearance of peak labels ............................................... 51
Energy cursor (keV) ............................................................................. 51

Spectral Match.................................................................................... 52
Using the Database Manager............................................................... 52
Setting up a search .................................................................................. 55

Quantifying Spectra ........................................................................... 58
Preparing the quantitative settings....................................................... 58
  Quant fit method ................................................................................. 58
  Matrix correction ................................................................................. 59
Initial quantitative analysis ................................................................. 60
  Automatic quantification ...................................................................... 60
  Automatic quantification for a series of spectra .................................... 60
  Manual quantification .......................................................................... 61
  Specifying quantitative output ........................................................... 62
  Rerunning quantitative analysis ......................................................... 64
  Ratioed elements ................................................................................... 65
  Calculating weight percentage .......................................................... 65
Developing quantitative analysis standards ........................................ 66
  Getting ready to create a standard ....................................................... 67
  Selecting properties for a standard ....................................................... 68
  Creating a standard ............................................................................. 69
  Using standards for quantification ....................................................... 73
  Standardless references ....................................................................... 74
Batch processing quantitative analyses .................................................. 74

Reports and Printing........................................................................... 77
Printer reports ......................................................................................... 77
Generating Microsoft Word reports ..................................................... 79
Generating Microsoft PowerPoint reports ............................................ 79
Copying objects to third-party programs .............................................. 80
Generating JPEG files ........................................................................... 80
Directly generating Microsoft Excel data .............................................. 80
  Using Feature Sizing data in Microsoft Excel ....................................... 81
  Using quantitative results in Microsoft Excel ....................................... 81

Software Reference Material ............................................................... 82
Operating system support ....................................................................... 82
Supported file formats ........................................................................... 82
More about projects and templates ..................................................... 83
  Project folders ...................................................................................... 84
Creating a new project ........................................................................... 85
Introduction

This manual explains how to use Thermo Scientific NSS spectral imaging systems. Except where noted, all the described software functions are available, either as standard features or as options, on all systems.

⚠️ **Warning**

The site and safety information manual that came with your system contains important safety information. This guide is available in several languages. Contact your local sales office for information about the languages that are available. Before you use the system, read the entire guide. To prevent personal injury and damage to equipment, follow the safety precautions contained in the guide whenever you use the system. ▲
**Manual conventions**

The following conventions are used in this manual to draw your attention to important information:

- **Note**
  Notes contain helpful supplementary information.

- **Notice**
  Follow instructions labeled “Notice” to avoid damaging the system hardware or losing data.

- **Caution**
  Indicates a hazardous situation which, if not avoided, may result in minor or moderate injury.

- **Warning**
  Indicates a hazardous situation which, if not avoided, could result in death or serious injury.

- **Danger**
  Indicates a hazardous situation which, if not avoided, will result in death or serious injury.

**Questions or concerns**

In case of emergency, follow the procedures established by your facility. If you have questions or concerns about safety or need assistance with operation, repairs or replacement parts, you can contact our sales or service representative in your area or use the information at the beginning of this document to contact us.

**Applications**

NSS is used with electron microscopes and x-ray detectors for a variety of applications, including the study of:

- General materials
- Metallurgical and geological samples
- Semiconductors
- Biological specimens
- Other electron microscope-based samples that can be analyzed with energy-dispersive spectrometry
**Capabilities**

NSS is a combination of high-performance x-ray microanalysis acquisition electronics connected to an energy-dispersive spectrometry (EDS) x-ray detector and microanalysis software installed on a dedicated x-ray microanalysis computer. The system can be connected to a variety of SEMs (scanning electron microscopes), TEMs (transmission electron microscopes) and STEMs (scanning transmission electron microscopes). In this manual, “NSS” refers to both hardware and software components.

**Software**

NSS software is compatible with the U.S., German and Japanese versions of Windows® XP operating system. It offers a single user interface program. Project Explorer ensures that your acquisitions and analyses are saved and organized in convenient project directories. In this manual, the English version of software is used for illustration and to describe operations and functions.

**Optional modules and software**

NSS supports the following optional software modules and additional software:

**Spectral Match** — Spectral Match software lets you search a spectrum against a database of spectra.

**Electron Microscope Column Communication** — This software integrates the reading and writing of selected column control parameters with NSS applications. This option is required for Analysis Automation.

**Integrated third-party software** — Microsoft Word is included for reports. Additional Microsoft Office programs, such as Excel® for data analysis and PowerPoint® for creating presentations, are available for purchase.
**Hardware**

NSS includes the following hardware components:

- Acquisition chassis that holds NSS electronics.
- NSS computer, video monitor, mouse and keyboard.
- Dedicated Ethernet connection between the acquisition chassis and the NSS computer.
- Ethernet, parallel, serial and USB interfaces for use with networks and peripheral devices. These interfaces are standard with the host computer.
- Optional components for serial or Ethernet connections to a microscope column, automated stage, beam current monitor, WDS spectrometer or parallel beam spectrometer.

**Microscope and x-ray detectors**

NSS can be installed on almost any microscope with EDS interface capabilities.

We offer several models of detectors with various atmospheric thin windows, resolutions and cooling options:

- NanoTrace Liquid-nitrogen cooled lithium drifted silicon (Si(Li)) x-ray detector
- UltraDry silicon drift detector (SDD) Peltier cooled
- SuperDry II electrically cooled Si(Li) x-ray detector

**Ethernet support**

Connections from the acquisition chassis to the computer are accomplished using a direct crossover Ethernet connection. Our support of Ethernet connections is limited to the support of NSS component connections. Contact your network administrator for other Ethernet issues.
**Acquisition chassis**

The acquisition chassis contains the electronic components needed to accept data from the EDS detector, electron microscope and WDS spectrometer and convert it to useful data for display by the computer.

Before you can collect and analyze data, power on the acquisition chassis. Use the power switch on the front panel.

**Active LED** – The system is on and working. When you turn on the system, the green light does not turn on until the system has finished startup. LED is on solid until communications starts with the host PC. Double flashes indicate normal operation. Continuous fast flashes indicate an error condition.

The chassis is protected by two 250 V, 2 A, T-type (time lag) 5 mm x 20 mm fuses located in a fuse drawer on the rear panel. To access the fuses, use a small flat-blade screwdriver to pry the drawer out of the chassis.

**Danger**

Avoid shock hazard. Always use an exact replacement for the fuses.
Getting Started

This chapter explains how to start NSS and use its basic features.

Before you use the system

Before you use NSS, you should be familiar with:

• Operating procedures for the electron microscope used with your spectral analysis system.

• Basic Windows procedures such as logging in to the computer, running programs and managing files.

• Terms and abbreviations used commonly in electron microscopy, including atomic symbols and energy lines (for example, O, Cu and L) as well as x-ray detector types (for example, EDS and WDS).

• Matrix correction methods; for example, ZAF and $\phi(pz)$.

Starting the software

To start NSS software:

1. Double-click the NSS shortcut on the desktop.

   If there is no shortcut on the desktop, use the Start menu. Click Start > Programs > Thermo Scientific > NSS.

2. When the Project Explorer opens, select an existing project or create a new one.

   NSS starts in Spectrum mode by default but, if possible, returns to the mode used when the program was last closed.

Notice

When you are finished working, be sure to shut down the computer properly before turning it off. Turning off a computer while programs are running can result in data loss, require software reinstallation or cause configuration changes. ▲
The NSS window

After you start the software and select or create a project, you are ready to use the NSS window to acquire, view, process and store data:

The window is highly customizable. You can arrange the window panes (containing analytical views) and move toolbars for your convenience.

**Note**

Work in a maximized window with a screen resolution of 1280 x 1024 for the best viewing.

**Window panes**

The NSS window is arranged with main panes for analysis and controls, plus panes on the left for navigating between analysis modes and files. The contents of the main panes change as you switch analytical modes.
**Navigation pane**

The navigation pane contains the icon for the Spectrum mode.

**File name and file list panes**

The file name you wish to be used to store the next analysis is entered in the box in the file name pane. Each successive acquisition appends an increasing number in parentheses to provide a unique file name. All files associated with the current mode are listed below the base name, in the file list pane.

In addition to managing your data in projects, you have the ability to assign a base file name for your data before acquisitions. In the file name pane, you can change the default base file name to something more specific to your application.

**Analysis control panes**

The analysis controls pane lets you set parameters for elements, processing and analysis along with quant results and comparison information.

Other control panels contain other tabbed dialogs which report control information or allow you to set additional controls.
**Spectrum pane**

The current spectrum appears in the spectrum pane. The location of the pane in the window depends on the analysis mode.

**Working from the toolbars**

The toolbars that are available depend on the current mode. The next sections identify the buttons on each toolbar. To view a toolbar button’s function, move the cursor over the button for one second.

**NSS toolbar**

The NSS toolbar contains buttons for general functions, including opening and saving files, copying, printing, exporting and viewing Help information.
**Acquisition toolbar**  The Acquisition toolbar contains buttons for acquisition operations, including starting, stopping, pausing and aborting. It also includes buttons for setting acquisition properties and microscope parameters.

![Acquisition toolbar diagram](image)

**Spectrum toolbar**  The Spectrum toolbar contains buttons for adjusting the scale and range of displayed spectra.

![Spectrum toolbar diagram](image)
Ident toolbar  The Ident toolbar contains buttons for identifying and quantifying a spectrum as well as a button for acquiring a WDS spectrum (if a WDS detector is attached to your microscope).

Elements toolbar  The Elements toolbar contains buttons for viewing KLM lines and labeling peaks.

Detector Selector toolbar  The Detector Selector toolbar contains a button for selecting a detector or detectors for acquiring data. Click the button to toggle between the available selections.
**Defining a project**

In order to acquire and analyze data, you must define a project to contain the data. When you first open the software, the Project Manager appears, allowing you to open an existing project or create a new one. Once a project is open, you can then set the acquisition properties and verify that the microscope properties are correct.

**Acquisition properties**

Before you can collect data, you must set the acquisition properties for your project. Click the Edit Acquisition Properties button on the Acquisition toolbar (or choose on Properties from the Edit menu) to display the Acquisition Properties dialog box:

![Acquisition Properties dialog box](image)

This dialog box lets you control how acquisitions occur. More information about the individual properties tabs is included later in this handbook.

**EDS tab** (and EDS 2 tab, if available) – “Setting spectral acquisition properties” in the “Spectrum Mode” chapter.
You also will want to check and, if necessary, adjust the microscope parameters for your project. Generally, these parameters are reported values from your microscope and do not change.

To check the parameters, select the detector(s) you plan to use for your project. Use the detector select button. Once the appropriate detector(s) is selected, click the Edit Microscope Parameters button (or choose Microscope Parameters from the Edit menu) on the Acquisition toolbar to display the Microscopic Properties And Status Bar Selection dialog box:

This dialog box lets you record column and stage settings. The available parameters vary according to the type of x-ray detector you have. If you have Column Automation, this dialog box reflects the microscope’s settings, and you can use it to control some aspects of microscope operation. Also use this dialog box to specify which items to display in the status bar.

**Note**

The EDS Slide Position, Storage Count Rate, Time Constant, EDS Dead Time and Takeoff Angle are associated with the currently selected detector. These parameters change as you change detectors. If both detectors are selected, the parameters are associated with EDS1.
Acquiring and Managing Data

Acquiring images and spectra

When you acquire data, EDS or WDS spectra are acquired from the area of focus.

NSS automatically names spectra and images as they are acquired they are acquired. Before you begin the first acquisition in a project, use the text box in the File Name window to set a base name for your data files.

Note

Before the acquisition, make sure all acquisition and processing properties are properly set. Information about those properties is included in the mode specific chapters that follow.

To acquire a spectrum or image:

1. Choose the acquisition mode from the Navigation pane.

2. Click the Start Acquisition button on the Acquisition toolbar.

The spectrum appears in the spectrum pane.

To pause the acquisition, click the Pause Acquisition button. To resume, click the Pause Acquisition button again.

To stop the acquisition and retain the data taken, click the Stop Acquisition button.

To stop the acquisition without retaining the data, click the Abort Acquisition button.

In Spectrum mode, you can view the analyzer status and Livetime and Deadtime information on the Detector Status tab in the bottom-right pane.

Acquisition and microscope information is shown in the status bar at the bottom of the screen. The Status Bar options are specified using Microscope Parameters in the Edit menu.
**Note**  The microscope parameter settings affect all modes, not just Spectrum mode. ▲

You can view peak identification manually during the acquisition or have peak IDs automatically applied during the acquisition.

The identification and analysis properties of the spectrum are specified on the Processing tab in the analysis controls pane.

**Viewing the spectrum**  You can change the size and range displayed for a spectrum by using the mouse, the Spectrum toolbar (shown below) or the number keypad (see the following table). Following an image extraction, the spectrum is displayed in its full range.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keypad Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset Spectrum</td>
<td>Home (7)</td>
</tr>
<tr>
<td>Move Spectrum Left</td>
<td>Num Lock + left arrow (4)</td>
</tr>
<tr>
<td>Expand Spectrum</td>
<td>Page Up</td>
</tr>
<tr>
<td>Compress Spectrum</td>
<td>Page Down</td>
</tr>
<tr>
<td>Move Spectrum Right</td>
<td>Num Lock + right arrow (6)</td>
</tr>
<tr>
<td>Increase Y Scale</td>
<td>Num Lock + up arrow (8)</td>
</tr>
<tr>
<td>Decrease Y Scale</td>
<td>Num Lock + down arrow (2)</td>
</tr>
<tr>
<td>Auto Scale To Highest Peak</td>
<td>End (1)</td>
</tr>
</tbody>
</table>

NSS Spectral Analysis System Handbook 15
Expanding the spectrum

You can expand a spectrum to look more closely at a specific part in any of three ways:

Drag right to expand the spectrum from the 0 energy.

Drag the spectrum left to expand the spectrum from the highest energy.

Click the Expand Spectrum button on the Spectrum toolbar to expand the spectrum from the center of the spectrum pane.

Compressing a spectrum

To reduce the magnification of the spectrum and show a greater energy range, click the Compress Spectrum button on the Spectrum toolbar.

Note

There is no mouse action to compress the spectrum. Double-click the spectrum to view the entire energy range.

Scrolling through a spectrum

You can scroll through a spectrum to look more closely at a specific part in two ways:

After a spectrum is expanded, drag left or right to scroll through the spectrum horizontally, or up and down to scroll vertically. As the spectrum is expanded or scrolled, it scales vertically to fit the tallest visible peak.

You can also click the Move Spectrum Left, Move Spectrum Right, Increase Y Scale and Decrease Y Scale buttons on the Spectrum toolbar.
Zooming in on a peak

To zoom in on a portion of the spectrum, hold down the Ctrl or Shift key and drag across the peak of interest. When you release the mouse button, the peak is enlarged.

Displaying the full spectrum

There are three ways to restore the spectrum to full view:

Click the Reset Spectrum button on the Spectrum toolbar.

Press Home on the keyboard.

Double-click the spectrum pane, but not near a peak.

Applying a log scale

Use the Change To Log Mode button to display the spectrum with a logarithmic vertical scale for the intensity values.

Managing files

After you acquire spectral data, you can rename it, add notepad text to it, save it, automatically identify it, quantify it, or manually change its peak labels. You can also open an existing spectral file and compare the spectra.
Project Explorer

All data is stored within projects. Each project can consist of several subprojects. A project includes the elements list, identification configuration, base file name, and acquisition properties from the project’s previous use. When you start NSS, Project Explorer appears allowing you to select an existing project or create a new one. Project Explorer allows you to visually manage your project folders.

Using the buttons in the upper left corner, you can:
- Create a new project
- Create a new folder
- Copy a project or folder
- Paste a project or folder
- Rename a project or folder
- Delete a project or folder

Opening and saving files

NSS or files from a third-party EDS system can be opened and saved from NSS acquisition and analysis modes. File names appear in the Files pane when you are in an acquisition or analysis mode that supports the file type. You can open many of the files by using a text editor like Notepad.

When a project is open, you can open any files included in that project by clicking the file name in the file list pane. To open a file outside the current project:

1. Choose Open from the File menu.
2. When Open dialog box appears, navigate to the directory that contains the file you wish to open.

3. Double-click the file or click the file then choose Open.

The file is imported into the project’s temporary directory. When you close the project, a prompt asks whether to save the file in the project folder or delete it. The temporary directory is emptied when you close the project.

You can save a file at any time by clicking the Save button on the NSS toolbar or choosing Save from the File menu. To change the file’s name, double-click the label, type the desired name and then choose OK. You can also select a pane and use Copy To in the Edit menu to save the pane to a JPEG file.

Most NSS files are stored in industry-standard formats, such as EMSA for spectra files. You can save data in an industry standard format. See the section entitled “Supported file formats” in the “Software Reference Materials” chapter later in this manual for complete information about supported file types.

Labeling a data set

Follow these steps to label the data set:

1. Double-click the image, map, or spectrum title at the top of the viewing pane.

A box appears:

![Labeling Box](image)

2. Enter the new label.

3. Choose OK.

Note If you change the image label, the file name is automatically changed to match the new label.
Renaming a file  When you rename a spectrum, map or map, the new name is saved with the spectrum in a new file and is used for printing. The original name is determined by Base Name in the file name pane. You can rename the file by double-clicking the spectrum name at the top of the spectrum pane or by changing the name in the Details dialog of the Attributes tab.

Adding note text  To add additional notes regarding the spectrum, click the Notes tab in the bottom-right pane. Enter the text in the notepad area. Notepad text is saved with the spectrum.
Spectrum Mode

Use Spectrum mode to acquire and analyze EDS spectra.

You can control how acquisitions occur by using the Acquisition Properties dialog box, available through the Edit Acquisition Properties button on the Acquisition toolbar or Acquisition Properties in the Edit menu. See the next section for details.

Note If you have our WDS detector installed on your microscope, the WDS Scan button on the Ident toolbar is active. Within Spectrum mode, you can acquire and compare both EDS and WDS spectra.
To set the acquisition properties for acquiring a spectrum:

1. Click the Edit Acquisition Properties button on the Acquisition toolbar.

You can also choose Acquisition Properties from the Edit menu.

The Acquisition Properties dialog box appears. Here is an example:

The EDS tab and EDS 2 tab (if available) let you set the detector parameters described below. Acquisition properties are stored in the .tnp file in the project folder. The following table describes the available properties. Use the Detector Selector toolbar to select the detector to use for acquisition. See “Detector Selector toolbar” in the “Getting Started” chapter.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Termination Criteria</td>
<td>The acquisition ends whenever any of the settings in the Termination Criteria box are exceeded. The settings are explained below.</td>
</tr>
<tr>
<td>Live Time Limit (s)</td>
<td>The duration of the acquisition in livetime seconds. A general rule for spectral acquisitions that do not have a high count rate is to use at least 100 seconds of livetime for acquisition. Setting this value to Zero means the acquisition runs continuously and you must stop the acquisition using the Stop button on the Acquisition toolbar or via another termination method.</td>
</tr>
<tr>
<td>Max Peak Counts</td>
<td>The acquisition terminates when the counts (on the vertical scale) in any channel reach this number. Setting this value to Zero means the acquisition runs continuously and you must stop the acquisition using the Stop button on the Acquisition toolbar or via another termination method.</td>
</tr>
<tr>
<td>Element and Line</td>
<td>Enter the atomic symbol for the element. Specify a KLM line for the element. Setting the symbol to Blank means that this option is ignored.</td>
</tr>
<tr>
<td>Max Counts</td>
<td>The acquisition terminates when the intensity for the selected element or region reaches this value.</td>
</tr>
<tr>
<td>User Define</td>
<td>If this is checked, you can redefine the low and high eV values for the region of interest.</td>
</tr>
<tr>
<td>Low (eV) and High (eV)</td>
<td>Low and high eV values corresponding to the user-defined region of interest energy range.</td>
</tr>
<tr>
<td>Low Energy Cutoff (eV)</td>
<td>X-ray counts below this energy are ignored during an EDS acquisition. The Auto setting changes the value according to the Pulse Processor Time Constant setting to remove the zero peak.</td>
</tr>
<tr>
<td>Max keV</td>
<td>X-ray counts up to this limit are included in the EDS acquisition. The Auto setting uses the setting of Accelerating Voltage in the Microscope Parameters And Status Bar Selection dialog box as the limit.</td>
</tr>
<tr>
<td>Acquire WDS Elements Simultaneously For Quantitative Analysis</td>
<td>If a WDS detector is available, this feature lets you acquire EDS and WDS elements simultaneously for comparative quantitative analysis.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Time Constant | Select a time constant from the drop-down list box. The list box displays the approximate maximum throughput for each time constant. In general, the resolution of the detector reduces as the throughput increases.

Auto automatically optimizes the DPP settings for the best throughput and resolution and keeps the dead time between 30% and 50%. (The range of rates depends on the detector type.) With the microscope set for best image and focus conditions, the software takes care of the rest. As the beam current changes, the software tracks it to maintain the optimum time constant setting.

The Projected Maximum Throughput value is the sum of real x-ray events and noise events, per second. As the Time Constant value changes, the Projected Maximum Throughput value changes, indicating the maximum number of both noise and x-ray events that can be processed at this setting.

Measure Beam Current Before EDS Acquisition | If you have the optional software and hardware, you can select this option to have the microscope beam current measured and stored automatically each time you acquire data. This eliminates the need to type the beam current value in the Microscope Parameters And Status Bar Selection dialog box (see “Microscope parameters” in the “Getting Started” chapter). The measured value appears on the Attributes tab in the lower-right pane. If your system uses a manually positioned Faraday cup, you will be prompted to position the cup before a measurement is made.

If Beam Current is selected in the Microscope Parameters And Status Bar Selection dialog box, you can measure the beam current at any time by clicking the BC button in the status bar near the lower-right corner of the NSS window:

| BC: 1.000 |

2. Set the parameters for your acquisition.

3. Choose OK.
Comparing spectra

You can compare two or more spectra in the spectrum pane. If you acquire a WDS spectrum, you can compare it with an EDS spectrum using this procedure.

To compare spectra:

1. Switch to Spectrum mode.

2. In the Spectrum list on the Compare Information tab in the analysis controls pane, check one or more overlapped spectra to compare against the base spectrum.

You can also select a synthetic, background or residual spectrum if SpectraCheck is active. The following table describes how these spectra are compared.

<table>
<thead>
<tr>
<th>Spectrum Type</th>
<th>Comparison</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synthetic</td>
<td>Based on the elements identified in the periodic table, the software calculates how the spectrum should appear and generates this synthetic spectrum.</td>
</tr>
<tr>
<td>Background</td>
<td>Applies the background spectrum.</td>
</tr>
<tr>
<td>Residual</td>
<td>The peaks of the elements defined in the periodic table are removed from the spectrum to create the residual spectrum. This spectrum shows what peaks were not accounted for in the original spectrum.</td>
</tr>
</tbody>
</table>
3. **In the Method box, select Overlap.**

The spectra are applied to the spectrum pane.

**Note** You can select Match instead to overlay and compare database spectra listed on the Match Results tab in the lower-right pane. See “Setting up a search” in the “Spectral Match” chapter for more information.

4. **Select the desired Normalize To option.**

These options adjust the selected spectra to the factor you select; they do not affect the base spectrum. The following table describes the available options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No normalization is applied.</td>
</tr>
<tr>
<td>Livetime</td>
<td>Normalizes the overlapped spectra to simulate the same length of acquisition time as the base spectrum.</td>
</tr>
<tr>
<td>Element</td>
<td>Uses the selected element to adjust the overlapped spectra to the height of the base spectrum. The peak or line used is based on accelerating voltage and the energy range of the spectrum.</td>
</tr>
<tr>
<td>Multiplier</td>
<td>Simple multiplier to scale all overlapped spectra by the multiplier value.</td>
</tr>
<tr>
<td>Range</td>
<td>Allows you to select an energy range to create multipliers with respect to the same region in the overlapped spectrum and the base spectrum. The overlapped spectrum is scaled by the entered multiplier value to normalize the overlapped spectra relative to the base spectra. Two range cursors appear in the spectrum pane, appearing as dashed vertical lines. Move each cursor to create the region.</td>
</tr>
<tr>
<td>Maximum</td>
<td>In the currently displayed range, scales the largest peak in each overlapped spectrum to match the largest displayed peak in the base spectrum. This method will scale a peak in an overlapped spectrum to match a base spectrum peak even if there is no energy overlap (that is, two WDS spectra).</td>
</tr>
</tbody>
</table>
### Option Description

| Maximum in Overlap | Scales the largest peak of each overlapped spectrum to match the largest peak of the base spectrum in the region where both spectra have data. For example, if you display a copper K WDS spectrum on a copper EDS spectrum, the largest peak of the WDS spectrum is scaled to match the copper K peak of the EDS spectrum, not the more intense copper L peak. This is unlike the Maximum option, which may scale a peak in an overlapped spectrum to match a base spectrum peak with no overlap. |

---

**SpectraCheck**

When SpectraCheck is active, a synthetic spectrum may be overlapped on the currently displayed spectrum. The synthetic spectra are based on the elements found in the identified spectrum. The SpectraCheck value represents the goodness of fit. A lower value indicates a better elemental fit.

SpectraCheck is an easy method to verify automatic qualitative analysis or manual peak identification of EDS spectra. This feature gives you greater confidence that your data interpretation is correct. It is part qualitative analysis, part quantitative analysis, part spectrum background calculation, and part statistical analysis. The algorithm takes the spectrum, performs a qualitative analysis, performs a quantitative analysis, calculates a spectrum background specifically for your detector and sample, creates a synthetic spectrum, and then calculates the SpectraCheck value. This value is displayed on the periodic table in the analysis controls pane.
Performing math operations on spectra with Spectrum Math software

One of the items in the Spectrum menu is Spectrum Math. Selecting the Spectrum Math menu item brings up a dialog box to allow you to add, subtract, multiply or divide any or all of the spectra in a project by a constant or by another spectrum. In addition, you have the option of getting the average or summed spectrum from any of the project spectrum files.

![Spectrum Math dialog box](image)

Naming the result file

You can type in a name for the result spectrum in the Result Name edit box. This is the spectrum that will be created when you click the Calc. Result button to perform the spectrum math operation.
Selection of files to process

You select which files in the project to use in the spectrum math calculation by clicking the Select button to bring up a file selection box shown below.

The type of files displayed for selection depends upon the NSS mode currently in effect.

<table>
<thead>
<tr>
<th>NSS Mode</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spectrum</td>
<td>.emsa</td>
</tr>
<tr>
<td>Point &amp; Shoot</td>
<td>.psmsa</td>
</tr>
<tr>
<td>Spectral Imaging</td>
<td>.fzs and .fzs a</td>
</tr>
<tr>
<td>Xray Linescans</td>
<td>.lsmsa</td>
</tr>
</tbody>
</table>

You can change the type of file display by changing the selection in the Files of Type combo box at the bottom of the dialog.

If you are selecting one file to process, you can click on the file name and click the OK button. For more than one file, you can hold the Ctrl key on the keyboard down and click the desired files. If the files are in a sequence, you can click the first file then hold the Shift key down on the keyboard and click the last file. When you click the OK button all the selected files are transferred to the Spectrum Math file list for processing.
For convenience, you can double left-click on a file name to choose it as a single file. This is equivalent to clicking the file and then clicking OK. You can also double right-click on a file name to add a file to the file list that is already defined.

**Selection of the math operation to perform**

You can choose the type of math operation to perform from the choices in the Spectrum Math operator combo box. The choices are:

<table>
<thead>
<tr>
<th>Math Operator</th>
<th>Result of the Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ (Add)</td>
<td>Add to each spectrum</td>
</tr>
<tr>
<td>- (Subtract)</td>
<td>Subtract from each spectrum</td>
</tr>
<tr>
<td>X (Multiply)</td>
<td>Multiply each spectrum</td>
</tr>
<tr>
<td>÷ (Divide)</td>
<td>Divide each spectrum</td>
</tr>
<tr>
<td>Average</td>
<td>Average several spectra</td>
</tr>
<tr>
<td>Sum</td>
<td>Sum several spectra</td>
</tr>
<tr>
<td>Normalize Beam Current</td>
<td>Normalize each spectrum by beam current</td>
</tr>
<tr>
<td>Normalize Livetime</td>
<td>Normalize each spectrum by livetime</td>
</tr>
<tr>
<td>Normalize Beam Curr. and LT</td>
<td>Normalize by both beam current and livetime</td>
</tr>
<tr>
<td>Normalize Vertical Full Scale</td>
<td>Normalize each spectrum by the maximum counts</td>
</tr>
</tbody>
</table>

When you choose the Average or Sum operators, each of the selected files is read into memory and the average or sum spectrum is generated by averaging or summing the data on a channel-by-channel basis.

Any of the other choices result in the math operation being performed on each of the selected files with a new result spectrum being created for each. A default name is used for each result spectrum after the first spectrum has been saved. This default name has the Result Name as a base name with a sequence number in parentheses appended to the base name.
The operand type

There are two ways that Spectrum Math can be performed on the selected files. One in which a constant is used in the math operation, and the second in which a spectrum is used. You can choose which type to use by clicking the choices in the Operand Type combo box. When you select Constant for the Operand Type, the constant that is present in the Operand combo box is used to perform the math operation. When you select Spectrum for the Operand Type, you must also select a spectrum from the file choices in the Operand combo box in order to conduct the math operation.

Processing the selected spectra

After you have made all the selections required by the program, the Calc. Result button at the bottom of the dialog is activated and the selected files can be processed. When you click this button a progress bar appears if several spectra are being processed along with an indication of which file in the set being analyzed. All math operations are performed on a channel by channel basis. The calculations are conducted with floating point arithmetic. Upon completion of the calculation for a given channel the floating point number is rounded to the nearest integer count value before the result is stored. If the calculation results in a negative number for the number of counts in a channel, the negative value is stored in the spectrum. All result spectra are stored in the ~temp directory for the project.

When you normalize a selected spectrum to a constant beam current or livetime, the constant beam current or livetime is stored with the attributes of the result spectrum. The normalization of a constant beam current and livetime is the same as livetime normalization. The counts of the result spectrum will be normalized to what they would be if the constant beam current or livetime had been used for the spectrum acquisition.

However, if you normalize a selected spectrum to another spectrum, the result spectrum will have counts that would have been present if the selected spectrum had been counted with the same beam current or livetime as the Operand spectrum. Upon completion the result spectrum will have attributes that reflect those of the Operand spectrum upon which the normalization is based.

Each result spectrum generated by Spectrum Math has an entry in the Notes section that shows the math operation that was conducted to obtain the spectrum. If a result spectrum is from the Average or Sum operation, all
spectra used to calculate the average or sum are listed in the spectrum Notes section.

When a result spectrum is created by Spectrum Math, the date and time of creation is stored with the spectrum attributes. Other attributes are based on the spectrum being processed or for Average and Sum on the first file processed.

**Resetting the dialog**

You can initialize the Spectrum Math dialog by clicking the Reset button. This clears the selected file list and resets the Result Name to a default based on the Base name for the project. It also resets the Operator to Add, the Operand Type to Constant and the Operand to 1.0.

**The right click menu**

If you click right when the cursor is within the dialog boundaries, a menu is displayed so that you can easily perform common actions. The menu items are:

- Clear the Selected Spectrum List
- Add Current to List
- Calculate the Result Spectrum

The first permits you to remove all spectra from the selected file list without performing a complete reset of the dialog. The second gives you an easy way to add a currently displayed spectrum to the selected file list. And the third is an alternate way to start the Spectrum Math processing of the selected spectra.

**Ending the dialog**

When you have completed the Spectrum Math operations for your project, click the Cancel button, or click the X in the upper right corner to end the dialog.
Performing math operations on regions of interest

The Region Tool tab in the bottom-right pane lets you add, subtract, multiply and divide two selected regions of interest in terms of net and gross counts. You can choose to work with either counts or rate data.

You can also simply report the gross and net counts for a single region. This tab is useful for finding peak ratios or ratioing a peak to the background.

The background for calculating net intensities for regions is determined by using the mean of five neighboring channels on either side of the region and fitting a linear curve between the two mean values.

You can include the results of math operations in your printed output by selecting ROI Results on the Spectra tab of the Page Setup dialog box, available through Page Setup in the File menu.

Region settings are stored in the .tnp file in the project folder.

To perform math operations:

1. **Specify the first region to use in the operation.**

   To the left of Operator on the Region Tool tab, click the Element down arrow button to display a periodic table, and then click the desired element. Select the desired line for the element from the Line drop-down list box.
You can also specify up to five numbered regions that are not associated with an element and use them in operations instead of selecting an element. For example, you can specify a background region and divide an element region by it. Type “user” in the appropriate Element text box, and then enter the region limits in the User Region Range (eV) text boxes. You can also drag the vertical dashed lines in the spectrum pane to specify the limits. To specify a region’s number, use Line to select or enter a number.

2. **Select the desired math operation from the Operator drop-down list box.**

   The operation will be performed in the order shown on the tab; for example, (first region) + (second region).

3. **Specify the second region to use in the operation just as you did the first region, except use Element and Line to the right of Operator.**

4. **Click the [+] button.**

   The operation and the results appear in the list at the top of the tab.

   To delete an operation, click it and then click the [-] button.
Preparation for an Analysis

When preparing for an analysis, you can select elements for it, adjust for oxides, specify the identification sensitivity, and set the processing parameters.

**Selecting elements for analysis**

Following a peak identification, the software creates a list of possible elements in the periodic table on the Element Setup tab. Here is an example:

![Periodic Table Example](image)

You can refine these results to search for or identify specific elements or exclude other elements.

Elements marked as “Identified” are used in quantifications.

**Note**

The periodic table does not change when you switch analysis modes. This lets you analyze a spectrum in one mode and then switch to another mode and use the same identification results.

Any edits to the periodic table are stored in the project template.
Highlighting elements for analysis

The next sections explain how to highlight elements in the periodic table for analysis.

Automatic selection

The software can automatically identify the peaks in spectra. It scans for all elements in the periodic table except for those marked “Excluded.”

Hydrogen, helium, lithium, the noble gases and the actinide and lanthanide series elements are excluded by default.

When analysis is complete, the results appear in the periodic table.

To identify and label peaks, click the Identify Spectrum button on the Ident toolbar.

Manual selection

To edit an element’s status, right-click the element in the periodic table and choose the desired status from the pop-up menu.

You can also click the element repeatedly until it is the color that corresponds to the status you want to apply.

The following labels and colors are available.

<table>
<thead>
<tr>
<th>Label</th>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive (default)</td>
<td>light gray</td>
<td>The element was not identified.</td>
</tr>
<tr>
<td>Identified</td>
<td>bright green</td>
<td>The element was identified in the sample.</td>
</tr>
<tr>
<td>Excluded</td>
<td>dark gray</td>
<td>The element will not be included in any identification. Choose this label before analysis.</td>
</tr>
<tr>
<td>Always Identified</td>
<td>magenta</td>
<td>The presence of the element will be determined. Choose this label before analysis.</td>
</tr>
<tr>
<td>Label</td>
<td>Color</td>
<td>Meaning</td>
</tr>
<tr>
<td>------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Possible</td>
<td>orange</td>
<td>The element could be in the sample but was not confirmed during automatic peak identification.</td>
</tr>
<tr>
<td>Selected</td>
<td>red outline</td>
<td>The element is currently selected for operation.</td>
</tr>
<tr>
<td>Near</td>
<td>cyan outline</td>
<td>The element’s KLM lines are close to the energy cursor in the spectrum pane. This changes as you move the cursor.</td>
</tr>
</tbody>
</table>

**Setting advanced element parameters**

Using the Advanced Element dialog box, you can obtain information about elements that are included in a compound. You can correct for elements that are chemically bound as oxides, nitrides, borides, carbides, or fluorides. This feature provides information about a compound, the individual element being analyzed, and the binding element.

1. In the periodic table on the Element Setup tab, click the bound element and then choose Advanced.

2. When the Advanced Element dialog box appears, choose how the quantification is to be applied to this element.

![Advanced Element dialog box]

**Calculated** – To obtain a calculated concentration of an individual element or a compound including Weight % for the individual element, the binding element, and the compound as a whole, choose Calculated.

**By difference** – If you are using a quant method that employs full standards, you can choose By difference. With this application, the analyzed element weights are subtracted from the total sample weight,
and the difference is reported as the weight of the element you selected. This option can be used for individual elements only.

**Fixed** – In samples that have an element of known concentration, you can choose a fixed percentage of the total sample weight to be reported as the Weight % of the element. For this option, enter the fixed percentage in the text box. This option can be used for individual elements only.

3. To analyze a compound, choose Use Compound and then select the binding formula from the Compound Formula list box.

4. To analyze an element using a standards-based method, choose Use Derivative References.

5. Where overlapping peaks are expected in standards-based data, leave both Use Compound and Use Derivative References unchecked.

6. Identify the EDS detector or WDS spectrometer that is the data source for the spectrum and element you are analyzing.

7. If you chose a quantification method that uses Cliff-Lorimer, select Ratio Element if this element is the ratio element.

8. When you are finished, choose Close to save the element analysis information and return to the Element tab.

**Specifying lines for quantification and display**

NSS identifies which lines are used for quantitative analysis based on the element and the accelerating voltage. If you decide to use a different line, use the Lines Utilized drop-down list boxes on the Element Setup tab to select a line. Some elements might have only one selection.

If a line is too close to the accelerating voltage, set Overvoltage on the Analysis Setup tab in the analysis controls pane to a higher voltage for quant data.
To exclude an element from quantitative results when it is identified as present in the sample (for example, elements for anti-charging coatings), set Quant in the Lines Utilized box on the Element Setup tab to Absent.

**Note**
Your changes are permanent and applied to future analyses in the current project until the history is cleared. ▲

**Excluding elements from quantitative results only**

Follow these steps to exclude an element from quantitative results:

1. **In the periodic table, click the element you want to exclude.**

2. **Set Quant in the Lines Utilized box to Absent.**

**Excluding elements from peak identification analysis**

To exclude an element from the analysis, in the periodic table right-click the element you want excluded and choose Excluded from the pop-up menu.

You can also click the element repeatedly until it is set to Excluded (dark gray).

The L, A and n boxes in the periodic table all work the same to toggle excluded lanthanide, actinide and noble gas elements, respectively. When you click one of the L, A or n boxes, the elements in that group are toggled according to these rules:

- If an element was excluded before, it changes to Inactive.
- If an element was anything other than Excluded, it becomes Excluded.

Helium, hydrogen and lithium are always Excluded regardless of how you mark them, because those elements have no detectable x-ray lines.

**Clearing identification results**

The Clear button in the Element Setup tab has two functions:

- To clear the identification results from the one spectrum currently displayed, make sure History is not selected and then choose Clear.

- To clear the cumulative identification results from all previous analyses in the project and the current spectrum, select History and then choose
Viewing the history periodic table

The history periodic table displays the cumulative identification results from all previous spectra within the project. Select History on the Element Setup tab to view the cumulative identification results for the open project. Results from an identification are added to the history when you do any of the following:

- Acquire a spectrum
- Run a quantitative analysis
- Close the project

When History is selected, those elements in the history are used for analysis. When History is not selected, only the current spectrum elements are used.

To clear the entire history for the project, select History and then choose Clear.

Specifying identification sensitivity

On the Analysis Setup tab in the analysis controls pane, set Ident Sensitivity to how large a peak must be before it is detected.

A larger value reduces the number of element labels on the spectrum by making the peak detection algorithm less sensitive. The default value is 5.
The peak-finding algorithm smoothes the spectrum and searches it for local peaks. If the ratio of the height of a peak to the error at the same point exceeds the Ident sensitivity factor, the peak is identified.

**Note**
The other parameters on the Analysis Setup tab deal with quantitative analysis or Spectral Match. See the “Quantifying Spectra” chapter or “Identifying Spectra With Spectral Match” chapter.

### Setting processing parameters
The parameters on the Processing tab in the analysis controls pane let you specify the types of identification and analysis that will automatically take place after data is acquired.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto ID</td>
<td>If Auto ID is active, the software identifies the spectrum peaks with each acquisition. If Auto ID is not active, you must click the Identify Spectrum button on the Ident toolbar to see identification results.</td>
</tr>
<tr>
<td>Feature</td>
<td>Instructions</td>
</tr>
<tr>
<td>---------</td>
<td>--------------</td>
</tr>
<tr>
<td>Quant</td>
<td>When Quant is active, the software calculates the quant information and displays it on the Quant Results tab. If Quant is active, Auto ID must be active unless you are in History mode. If Quant is inactive, you can still do a quantification by identifying the elements to quantify and clicking the Quantify Spectrum button on the Ident toolbar.</td>
</tr>
<tr>
<td>Match</td>
<td>When Match is active, the software searches the specified databases after an acquisition or extraction. When Match is inactive, you can still perform a search by clicking the Spectral Match button on the Ident toolbar. See the “Identifying Spectra With Spectral Match” chapter for information about Spectral Match.</td>
</tr>
</tbody>
</table>
Identifying Peaks Manually

Although NSS automatically identifies peaks following or during an acquisition, several tools are included for manual peak identification:

- Peak ID lines following automatic identification or by clicking the Identify Spectrum button on the Ident toolbar.
- KLM marker scrolling using the left and right arrow keys.
- Element scrolling using the up and down arrow keys.
- Mouse- and keypad-driven spectrum shifting and scrolling.
- Standard, logarithm and outline spectral display.

**Note**
The identification sensitivity controls how strong a peak must be to be automatically identified. See “Specifying identification sensitivity” in the “Preparing for an Analysis” chapter.

**Locating possible elements**
NSS displays lines that locate each peak in the spectrum when KLM markers are hidden. The automatic peak identification function labels each identified peak. Use these markers as a starting point for manual peak identification. The Elements toolbar contains tools for labeling peaks and displaying KLM lines.

**Viewing KLM lines**
You can view the KLM lines in two ways. The first is on the Elements toolbar:

Click the KLM Lines On/Off button. The KLM lines appear on the spectrum for the selected element. From here you can click other elements or scroll through the periodic table using the arrow keys.
The second is in the Spectrum Properties dialog box and allows for more customization:

1. **Right-click the spectrum pane.**
   
The Spectrum Properties dialog box appears.

2. **On the KLM Page tab select Show KLMs.**
   
   Here you can adjust the types and range of lines you want displayed.

3. **Choose OK.**

4. **In the periodic table on the Element Setup tab, click the element.**
   
The KLM markers appear in the spectrum.

   The bottom-left corner of the spectrum pane shows the symbol of the current element that has its KLM markers displayed.

   Use the arrow keys to scroll through the periodic table and see the KLM lines for each element.

## Scrolling KLM lines with keyboard arrow keys

You can scroll KLM markers by using the arrow keys on your keyboard.

Here is an example showing KLM lines displayed for tungsten:
To display the KLM markers, click the KLM Lines On/Off button on the Elements toolbar. The atomic symbol for the element with its KLM lines displayed appears in the lower-left corner of the spectrum pane.

The Next Element and Previous Element buttons scroll the KLM markers by atomic number. You can also use the left and right arrow keys on the keyboard:

The Element Search Up and Element Search Down buttons use the energy reading at the energy cursor to search an NSS database of element lines and display candidate KLM lines for each element found. You can also use the up and down arrow keys.

A low-pitched beep signals that you have reached the end or the beginning of the possible elements.

**Scrolling for KLM lines on the spectrum**

You can place the energy cursor at a point on the spectrum and then search for elements that have KLM lines higher or lower than that point.

To search for KLM lines:

1. **Click the spectrum to place the energy cursor at a point of interest.**

2. **Click the Element Search Down or Element Search Up button, or press the up or down arrow key on the keyboard.**

A high-pitched beep means the software found another element near the cursor. The element is outlined with a dotted red border in the periodic table and its KLM lines appear on the spectrum. The elements with KLM lines near the cursor are outlined in cyan on the periodic table.

A low-pitched buzz means you have reached the end of the periodic table from that cursor point.
Finding possible elements at a peak

NSS provides several aids in locating an element at a peak, including peak ID lines, labels and KLM lines.

To view a list of possible elements, place the energy cursor on the peak. Those elements with a K, L or M energy level near the cursor position are outlined with a cyan border in the periodic table. You can change any of them to Identified if they match the element you are seeking.

Some knowledge of the sample and other element peaks is useful in determining which elements should be identified manually.

Customizing x-ray line energies and intensities

Use Element X-ray Lines in the Spectrum menu (whenever the spectrum pane is active) to add or adjust element x-ray line energies and relative intensity values. This can improve manual peak identification when lines are closely spaced. Also, since x-ray line energies and intensities are used to determine counts with the Gaussian method, better quantitative analysis results (element weight % concentrations) can be obtained with accurately adjusted values.

Follow these steps:

1. **Choose Element X-ray Lines from the Spectrum menu.**

The X-ray Lines dialog box appears:
2. **Specify the element whose energies or intensities you want to adjust.**

You can type the element symbol in the Element text box. You can also click the down arrow button to the right and then click the desired element in the periodic table that appears.

3. **Specify the lines series you want to work with.**

You can type the line letter (K, L or M) in the Line Series text box or select a letter from the drop-down list box.

The lines in the specified series are listed along with their energies and intensities as currently stored in the database.

4. **Select the line whose energy or intensity you want to adjust by clicking it in the list.**

The selected line’s current values appear in the Selected Line box.

5. **Type the desired values in the Energy and Intensity text boxes, and then click the button.**

For most elements the energies are well known; normally only the intensity is adjusted. However, you may find some differences in energies when comparing different published tables.

The new information appears in the list.

6. **If you want to add a line to the list (and to the database), select it from the Line drop-down list box, enter the desired energy and intensity values, and then click the button.**

7. **If you want to delete a line from the list (and from the database), select it and then click the button.**
8. If you want to restore the default values for the listed lines, click the Default Values button.

9. When you are finished customizing the x-ray line energies and intensities, choose OK to make your changes permanent.

Choose Cancel if you don’t want to change the database.

**Labeling peaks**

After you have manually identified a peak, you might want to label it on the spectrum for reference and reports. The Peak ID labeling options are in the Spectrum Properties dialog box.

You can use Auto ID on the Processing tab in the analysis controls pane to specify whether to display peak labels during or after an acquisition automatically. See “Setting processing parameters” in the “Preparing for an Analysis” chapter.

**Labeling all peaks**

To label all peaks:

Click the Identify Spectrum button 📉 on the Ident toolbar.

**Editing the label for a specific peak**

Follow these steps to edit the label for a specific peak:

1. Double-click a peak label.

Here is an example:
A drop-down list box appears containing the possible elements for that peak:

2. Select an element.

3. Choose OK.

**Adding peak ID labels for a specific element**

To add peak ID labels for a specific element, click the element in the periodic table on the Element Setup tab until it is bright green.

You can also right-click the element and choose Identified from the pop-up menu.

If KLM lines are displayed, you can also click the element in the periodic table and then click the Label Peak button on the Elements toolbar. (You can turn the display of KLM lines on or off with the KLM Lines On/Off button on the Element toolbar or with Show KLMs on the KLM Page tab in the Spectrum Properties or Properties dialog box.) You can also right-click the element and choose Always Identified from the pop-up menu.

Labels appear for all the element’s KLM lines.

**Removing peak labels**

You can remove a single peak label or all the peak labels for one element.

To remove a single peak label:

1. Click the label.
2. Press the Delete key on the keyboard.

To delete all the peak labels for one element:

1. Right-click the element in the periodic table.

2. Choose Inactive from the pop-up menu.

**Searching for KLM lines and adding labels**

Follow these steps to use the keyboard to search for KLM lines and add labels:

1. **Click the peak of interest to place the cursor over it.**

   The elements that have a line near the cursor location are labeled as “Near” (cyan) in the periodic table. The currently selected element is outlined in the table with both red and light blue.

2. **Use the keyboard to move to another element.**

   Press the up arrow key to move to the next Near element in order of increasing atomic number.

   Press the down arrow key to move to the next Near element in order of decreasing atomic number.

   Press the right arrow key to increase the atomic number by one.

   Press the left arrow key to decrease the atomic number by one.

   **Note**  “Excluded” elements are skipped. ▲

   The KLM lines appear in the spectrum pane as you move from element to element.

3. **To add a label for the selected element, press the space bar on the keyboard.**
Changing the appearance of peak labels

Follow these steps to change the appearance of peak labels:

1. Right-click the spectrum.

2. When the Spectrum Properties dialog box appears, on the Peak Page tab set Labels to Short or Long.

3. Click the Peak Label Font button.

4. When the font dialog box opens, set the font parameters as desired and then choose OK.

5. Choose OK to close the Spectrum Properties dialog box.

**Note**
The None option turns off all Peak ID labeling. If you try to label an individual peak, it will not appear on the spectrum. ▲

**Energy cursor (keV)**

To turn the energy cursor on, click the Energy Cursor On/Off button on the Elements toolbar. The energy and counts appear in the upper-left corner of the spectrum.
Spectral Match

Optional Spectral Match lets you identify a spectrum by searching a database of spectra.

Access the Spectral Match Database Manager by clicking the Match Database button on the Analysis Setup tab for your spectrum. The manager allows you to select the database to search and to manage your databases.

When the Database Manager dialog box opens you can create a new database, add spectra to an existing database and organize your databases into groups.

When you wish to create a new database, you can import and modify an existing database, create a database from a spectrum, create one manually, or create one from a CSV file.
Use the Manual button to enter a known composition for a compound.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Match Name</td>
<td>Enter a descriptive name for the new compound.</td>
</tr>
<tr>
<td>Acceleration and Zero</td>
<td>Enter an acceleration voltage in kV and a width for the zero peak in eV that corresponds to the values for unknown compound spectrum you are matching.</td>
</tr>
<tr>
<td>Composition</td>
<td>Compositions can be entered as weight percent values, atomic percent values, or number of atoms from a stoichiometric formula for each element.</td>
</tr>
</tbody>
</table>

After you enter the composition click Show Spectrum to place the simulated data into the spectral display so it can be examined. If you wish to use the simulated spectrum for matching, click Define For Match. If the simulated spectrum is not correct, you can use Clear to erase all composition elements. Once the elements are deleted, a different compound composition can be entered. Use Close to return to the Database Manager.

From CSV allows you to select a compound composition from a library of compounds in a CSV (comma separated variable) file format.
A CSV file named Match Library.csv is supplied with the NSS system. It is located in the MatchDatabases directory with a backup copy in the bin directory.

As necessary, you can change the acceleration voltage or zero peak width values to correspond to the expected values for the spectrum being matched. The zero width value can be found in the Details dialog of the unknown spectrum’s attributes.

To define a spectrum for a compound in the library, select a compound and then click Define For Match. When only one compound is selected, the “Show Spectrum” button is active so that the spectrum can be placed in the spectral display for examination.

If you wish to use more than one compound from the library, press and hold the CTRL key and then click all of the compounds you wish to use. Once you have selected all the compounds, click Define For Match. Use Close to return to the Database Manager.
Setting up a search

Follow these steps to search the spectrum displayed in the spectrum pane against a database of spectra:

1. To select the spectral database to search, click the Match Database button on the Analysis Setup tab in the analysis controls pane.

2. When the Database Manager appears, select the desired database from Current Database drop-down list box and then choose Close.

3. Specify the maximum number of database spectra to find by setting Max. Number Of Match Results on the Analysis Setup tab.

4. Use Low and High on the Analysis Setup tab to specify the minimum and maximum energy, respectively, used to compare the spectra.

5. Use Chi-square Cutoff to specify a threshold that determines how similar a spectrum from the database must be to the unknown sample spectrum to be considered a match.

   The lower the calculated Chi-squared value between the sample spectrum and a database spectrum is, the more similar the two spectra are, with a perfect match having a value of 0.0.
A greater Chi-squared value indicates a poorer match, so using a larger setting loosens the requirements for the identification.

If the lowest calculated value for all the database spectra is greater than the specified value, the sample spectrum is considered unknown to the database.

6. **Click the Spectral Match button** on the Ident toolbar or choose Match from the Spectrum menu (whenever the spectrum pane is highlighted).

The results appear on the Match Results tab in the bottom-right pane. Here is an example:

<table>
<thead>
<tr>
<th>Match Name</th>
<th>Chi-squared</th>
<th>Spectrum Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cr-Co-rich</td>
<td>0.000</td>
<td>Cr-Co-rich</td>
</tr>
<tr>
<td>Turbine Spectrum(1)</td>
<td>64.057</td>
<td>Turbine Spectrum(1)</td>
</tr>
<tr>
<td>Example Spectrum</td>
<td>97.132</td>
<td>Example Spectrum</td>
</tr>
</tbody>
</table>

The smaller the match (Chi-squared) value on the Match Results tab, the closer the match spectrum from the database is to the unknown spectrum.

For a more direct comparison you can overlay match spectra on the current spectrum by checking the match spectra you want to overlay. (The Match option on the Compare Information tab in the access controls pane is selected automatically when you click the Spectral Match button.) The overlaid match spectra clear any currently displayed comparison spectra. The comparison normalization settings are used to scale the spectra as needed. You can click the Show All button to check all of the match spectra; click the Clear All button to remove all the overlaid match spectra.
You can include the results in tabular form in reports by selecting Match Results on the Spectra tab or Point And Shoot tab in the Page Setup dialog box.

As with other kinds of results, you can use Export To Word or Export To PowerPoint in the File menu to export the match results to Microsoft Word or PowerPoint and print them (if those programs are installed).
Quantifying Spectra

A quantitative analysis is performed on an acquired spectrum either from the current automatic peak identification or by performing a manual peak identification. Quantitative analyses are always created from the current periodic table on the Element Setup tab.

Preparing the quantitative settings

To prepare the quantitative settings, select the quant fit method, define standards (if using a quant fit method with standards) and select a matrix correction algorithm. See the next sections for details.

Quant fit method

On the Analysis Setup tab use Quant Fit Method to select a method to calculate k-ratios.

Note

You can switch from one method to the other and click the Quantify Spectrum button on the Ident toolbar again to compare results between methods.

The following table describes the available methods.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gaussian Without Standards</td>
<td>Uses Kramer’s Law to calculate and subtract a theoretical background. This would be a preferred method if you don’t have a reference for the peak (for example, radon).</td>
</tr>
<tr>
<td>Filter Without Standards (default)</td>
<td>Applies a digital top hat filter to remove the background from a spectrum before fitting the spectrum to the reference spectra provided by the software.</td>
</tr>
<tr>
<td>Gaussian With Standards</td>
<td>Uses Kramer’s Law to calculate and subtract a theoretical background. This is similar to Gaussian Without Standards except that you use standards developed on your own equipment. See “Developing quantitative analysis standards” later in this chapter.</td>
</tr>
</tbody>
</table>
### Feature

**Filter With Standards**
Applies a digital top hat filter to remove the background from a spectrum before fitting the spectrum to the reference that you developed on your own equipment. See “Developing quantitative analysis standards” later in this chapter.

---

You can use Element X-ray Lines in the Spectrum menu to add or adjust x-ray line intensities for performing quantitative analysis with Gaussian fitting. See “Customizing x-ray line energies and intensities” in the “Identifying Peaks Manually” chapter for more information.

---

### Matrix correction

Matrix correction converts measured peak intensities into quantitative results. These methods calculate differences between elements in pure form and elements in composition. If you use matrix correction, select a calculation method.

The following table describes the available corrections.

<table>
<thead>
<tr>
<th>Correction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proza (Phi-Ro-Z)</td>
<td>Calculates the depth distribution of x-rays emitted from the sample. This method is used in SEM applications, especially for light elements in a heavy matrix. PROZA corrections are based on the methods of Bastin, et al.</td>
</tr>
<tr>
<td>ZAF</td>
<td>Corrects peak intensities for average atomic number (Z), absorption (A) and fluorescence (F) factors.</td>
</tr>
<tr>
<td>Cliff-Lorimer Without Absorbance</td>
<td>Provides metallurgical and biological thin section (MBTS) corrections based on relative elemental K factors (Cliff-Lorimer factors). The correction assumes there is no absorption. Use the Advanced Element dialog box to identify the ratio element. This method is used in TEM/STEM applications.</td>
</tr>
</tbody>
</table>
### Correction

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cliff-Lorimer With Absorbance</td>
</tr>
</tbody>
</table>

Same as above, but corrects for absorption in thicker samples. This method requires knowledge of the sample density. Use the Advance Element dialog box to identify the ratio element. This method is used in TEM/STEM applications.

---

**Initial quantitative analysis**

When you acquire spectral data, NSS identifies the elements in the spectrum. An identification (either automatic or manual) marks them in the periodic table on the Element Setup tab in the analysis controls pane. Quantitative analysis uses these identified elements.

To change the settings that the software uses for quantification, use the Analysis Setup tab. You can also set the software to automatically perform a quantitative analysis following an automatic identification.

In the periodic table, right-click any elements you want excluded in your quantitative analysis results and choose Inactive.

**Automatic quantification**

Follow these steps to perform an automatic quantification:

1. Click the Identify Spectrum button on the Ident toolbar.

2. Click the Quantify Spectrum button on the Ident toolbar.

**Automatic quantification for a series of spectra**

Follow these steps to perform an automatic quantification for a series of spectra:

1. On the Processing tabbed dialog, choose enable Auto ID and Auto Quant.

2. Choose Quant Analysis from the Batch Processing menu.

   A dialog box appears.
3. Locate and select the files you want to quantify.

   Hold down the Ctrl key or Shift key when selecting additional files.

4. Choose Open.

5. When the dialog box opens, enter a file name for saving the quant results.

6. If you wish to create a CSV file containing the results, choose Save from the NSS toolbar.

   A message shows the progress of the quantification.

**Manual quantification**

Follow these steps to perform a manual quantification:

1. **Mark the elements on the Element Setup periodic table as needed.**

   An elemental energy line (K, L or M) is preselected by the software based on the beam energy. To change to a different elemental line, select the new line in the Quant drop-down list in the Lines Utilized box.

   If an element is present in the sample, but you wish to exclude it in the quantitative calculation (for example, a coating material), set Quant to Absent.

2. **Choose Properties from the Edit menu.**

   The Properties dialog box appears.

3. **On the Quant Results tab, check the items you want to appear in the quantitative analysis results.**
Specifying quantitative output

The Quant Results tab on the Properties dialog (available from the Edit menu) allows you to specify the information you wish reported in the quantitative analysis results.

The following items are available.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Weight %</td>
<td>The total weight percentage in the sample for quantitative analysis.</td>
</tr>
<tr>
<td>Output X-ray Lines</td>
<td>The x-ray lines to display for quantitative analysis.</td>
</tr>
<tr>
<td>Output Precision</td>
<td>The level of precision in which the data is reported.</td>
</tr>
<tr>
<td>Line Type</td>
<td>The K-shell, L-shell or M-shell of the x-ray line.</td>
</tr>
<tr>
<td>Net Counts</td>
<td>The net counts in the peak measured for an x-ray line.</td>
</tr>
<tr>
<td>Net Count Error</td>
<td>The error shown as plus or minus one standard deviation for the measured net counts.</td>
</tr>
<tr>
<td>Intensity</td>
<td>The net counts divided by the livetime divided by the beam current to obtain counts per second per nanoampere.</td>
</tr>
<tr>
<td>Intensity Error</td>
<td>The error in the calculated intensity shown as plus or minus one standard deviation.</td>
</tr>
<tr>
<td>Source</td>
<td>The source of the net count measurement indicated by EDS (standardless EDS), EDS STD (EDS from a standard) and WDS (WDS measurement).</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>K-ratio</td>
<td>The ratio of the measured net counts divided by the net counts from a pure element sample.</td>
</tr>
<tr>
<td>K-ratio Error</td>
<td>The one-standard-deviation error in the K-ratio.</td>
</tr>
<tr>
<td>Z Factor</td>
<td>The atomic-number correction for an x-ray line.</td>
</tr>
<tr>
<td>A Factor</td>
<td>The absorption correction for an x-ray line.</td>
</tr>
<tr>
<td>F Factor</td>
<td>The fluorescence correction for an x-ray line.</td>
</tr>
<tr>
<td>ZAF Factor</td>
<td>The product of the atomic-number correction (Z), the absorption correction (A) and the fluorescence correction (F) for an x-ray line.</td>
</tr>
<tr>
<td>K Factor</td>
<td>The Cliff-Lorimer K factor for an x-ray line.</td>
</tr>
<tr>
<td>Weight %</td>
<td>The calculated weight concentration expressed as a percentage for an element in the sample.</td>
</tr>
<tr>
<td>Weight % Error</td>
<td>The one-standard-deviation error for the Total Weight % value.</td>
</tr>
<tr>
<td>Normalized Weight %</td>
<td>The calculated weight concentration for an element normalized so that the total weight concentration for all elements equals the Total Weight % value.</td>
</tr>
<tr>
<td>Norm. Weight % Error</td>
<td>The error in the normalized weight concentration shown as plus or minus one standard deviation.</td>
</tr>
<tr>
<td>Atom %</td>
<td>The atomic percentage of an element in the sample.</td>
</tr>
<tr>
<td>Atom % Error</td>
<td>The error in the atomic percentage shown as plus or minus one standard deviation.</td>
</tr>
<tr>
<td>Chemical Formula</td>
<td>The chemical formula used for calculating an element’s concentration by stoichiometry.</td>
</tr>
<tr>
<td>Compound %</td>
<td>The percentage of the compound in the sample represented by the chemical formula.</td>
</tr>
<tr>
<td>Normalized Compound %</td>
<td>The percentage of the compound in the sample normalized, so the total of all compound percentages equals the Total Weight % value.</td>
</tr>
<tr>
<td>Number Of Cations</td>
<td>The number of cations for an element based upon a number of oxygen atoms defined by the user.</td>
</tr>
<tr>
<td>Standard Name</td>
<td>The base name of the standard used to obtain quantitative results for an x-ray line.</td>
</tr>
</tbody>
</table>

When you are finished, choose OK to accept the output settings and close the dialog. Choose Cancel to exit the dialog without changing settings.
Once the output settings are in place, you can choose the Quantify Spectrum button on the Ident toolbar to begin quantifying your data. When the software completes the analysis, click the Quant Results tab in the analysis controls pane to view the results.

**Kerunning quantitative analysis**

Follow these steps to requantify a spectrum:

1. **Edit the Element Setup periodic table in the analysis control pane as necessary.**

2. **Click the Quantify Spectrum button on the Ident toolbar.**

   The Quant Results tab information changes to reflect the new quantitative analysis.

**Note**  For proper quantitative analysis results, click the Quantify Spectrum button any time you change the Element Setup periodic table.
To select a ratio element, you must be using one of the Cliff-Lorimer matrix correction methods. Specify the matrix correction on the Analysis Setup tab. Only one element can be a ratioed element. Follow these steps:

1. Select the element you want to ratio in the Element Setup periodic table.

2. Choose Advanced.

3. Check the Is Ratio Element box.
   
   This normalizes the k-ratio for that element to 1.

You can specify the weight of an element within a sample as a percentage or have the weight calculated. Follow these steps:

1. On the Element Setup periodic table, click the element for which you want to define the weight.

2. Choose Advanced.

3. Select Calculated or Fixed in the Quantification Of Weight % box.

   If you select Calculated, the software will calculate the percentage of the sample and show the percentage in the Quant results.

   If you select Fixed, enter a fixed percentage. The software will assume the sample contains that percentage of the element and take that into account when figuring the quantitative results for other elements.

4. Choose Close.
Usually running a quantitative analysis without standards is sufficient to meet the needs of most analyses. However, in some situations you may prefer to develop your own standards. Developing your own standard can be more accurate, since the standard and the samples are acquired under the same conditions (assuming that the take-off angle and the beam current are the same between runs).

Use the following guidelines to make your standards as accurate as possible.

- Aim for 10,000 integrated counts in the standard’s peak. This would result in a one percent error rate.

- Limit the dead time to less than 30% by adjusting the beam current or changing the pulse processor.

- Count when the microscope’s beam current is stable, and the beam current changes (during the acquisition) are no greater than one percent.

- The standard should be well characterized with known weight percentages and homogeneous in the region of analysis.

- The sample for the standard should be polished (smooth).

- Use a fixed-pulse processor rate instead of “auto” when doing quantitative analysis with user-defined standards. Always use that time constant when you perform quantitative analysis; otherwise, the Chi-squared fitting results will be too high.

**Note** The samples you compare with your standards should be acquired under the same conditions as the standard. The exception to this rule is that beam intensity can vary, as the software adjusts for beam intensity differences. However, you should use a fixed pulse processor rate instead of “auto” when performing quantitative analysis using standards.

You can create standards for pure elements and multi-elements.

**Note** If you do not create a standard for every element in a multi-element standard that you are analyzing, the software uses the factory standards for those elements without custom-defined standards.
Getting ready to create a standard

Follow these steps to prepare to create a standard:

1. Prepare the sample (that you’re using to develop a standard).

2. Click the Spectrum icon in the navigation pane.

3. Open the project in which you want to create a standard.

   See “Opening a project” and “Creating a new project” in the “Getting Started” chapter.

4. Click the Start Acquisition button.

5. Click the Identify Spectrum button.

6. Choose Properties from the Edit menu.

   The Properties dialog box appears.
7. On the Quant Results tab check the options that you want to display in the final Quant Results report.

8. Choose OK.

**Selecting properties for a standard**

Follow these steps to select properties for a standard:

1. **On the Analysis Setup tab, in the Quant Fit Method area, select either Gaussian With Standards or Filter With Standards.**

   See “Quant fit method” earlier in this chapter.

2. **Set Correction Method to the desired method.**

   See “Matrix correction” earlier in this chapter.

3. **Select the Element Setup tab in the analysis controls pane.**

   If some of the identified elements (green) are not in the standard (such as carbon from a carbon coating), you may want to mark them absent for quantitative analysis. In the Lines Utilized area, select Absent from the Quant drop-down list box. Repeat this until only the elements in the standard have lines selected in the Quant area.
Creating a standard  Follow these steps to create a standard:

1. Select (outline in red) the element for which you are creating the standard.

2. On the Standards tab in the lower-right pane click the Add Standard button.

   The Add Standards dialog box appears.

   ![Add Standards dialog box]

   **Note**  If you make a mistake defining a standard, you cannot edit the standard. Instead, erase the standard with the mistake and start again.
3. **Choose New Standard.**

The New Standard dialog box appears:

![New Standard dialog box](image)

The Element listed in the Element and Line area should be the element for which you are defining a standard. (The ratio element for a TEM multi element standard should be defined first.) If it is not, choose Cancel and return to the Element Setup tab to highlight the required element.

4. **If your standard has more than one element, check the Multi Element Standard box.**

5. **Set Concentration Data Type to the desired type.**

Enter the elements and the known composition in the boxes that appear.
For multi-element standards, you can select a concentration data type from among weight %, atomic % or atom count.

6. **If necessary, adjust the Energy Range values either by manipulating the grid lines on the spectrum or by manually typing in values.**

The energy range should include only peaks from the element. If peaks from other elements overlap, remove the check mark in the From Current Spectrum check box. In this case the filter method’s reference shape for the element will be obtained from the built-in reference library.

7. **If you want to adjust element calibration values for standardless analysis, select Use As Standardless Reference and then enter the desired Proza and ZAF calibration factors.**

For correction methods without standards, a factor greater than 1.0 enhances the weight percent for the element; a factor less than 1.0 reduces the weight percent.

8. **If desired, change the name of the standard.**

When naming a standard, consider the following issues:

When you create a multi-element standard, do not name the standard by the name of a single element. In the example above, you would not want to name the standard “copper.”

When you create a multi-element standard, keep the standard name the same for all the elements in the standard. As long as the name is the same, when you select the next element to define (in the Periodic Table), the New Standard dialog box displays all the elements defined previously.
When you create standards, an NSS Standards folder is created in the folder defined by the path on the SERVICE Instrument Configuration page, the default location is “C:\NSS Libraries”. This folder contains all the created standard files. These files have the element being defined in the standard at the beginning of the base standard name and the file extension .std at the end of the base standard name. In the example above, the file name for the Cu-K standard in the NSS Standards folder is Cu-K-Cu Au mixed.std.

9. **Choose OK.**

The Add Standards dialog box appears with the new standard listed at the top of the database list.

You can set up multiple standards for the same element.

10. **If you are creating a multi-element standard, select the next element in the periodic table, and then return to step 1.**

Repeat this procedure until you have done all the elements in your multi-element standard.

**Note** If you do not create a standard for every element in a multi-element standard that you are analyzing, the software uses the factory standards for those elements without custom-defined standards. ▲
Using standards for quantification

Follow these steps to use your standards for quantification:

1. **On the Standards tab in the lower-right pane, click the Add Standard button.**

   The Add Standards dialog box appears:

   ![Add Standards dialog box](image)

   The Add Standards dialog box allows you to select and add standards to the analysis.

2. **Select (highlight) all of the standards you wish to use for quantification.**

3. **Choose Add Selected.**

   The standards appear in the Standards In Use area.

4. **Click the Quantify Spectrum button on the Ident toolbar.**

5. **When the software completes the analysis, it beeps and lists the results.**

   Click the Quant Results tab in the analysis controls pane to view the results.
Note  The lower the Chi-squared value, the better is the fit. A fit that is within counting statistics, on average, is 1.0. As a general rule, try to keep the Chi-squared value under 10.

Standardless references  The Add Standards dialog also can be used to view and select standardless references that you have defined.

Batch processing quantitative analyses  Batch processing allows you to perform a quantitative analysis and/or peak identification for a series of spectra.

1. **Save all spectra to be analyzed in the project directory.**

Batch processing cannot be applied to spectra in the ~temp directory.

2. **Select the type of quant analysis to be conducted.**

Choose Auto ID to identify peaks.

Choose AutoQuant to perform a quantitative analysis using the process parameters.
Choose Auto Match to identify elements and compounds using spectral match.

3. **Choose Quant Analysis… from the Batch Processing menu.**

4. **When the dialog box appears, select the spectral files to be processed and then choose Open.**

![Select the files to identify dialog box](image)

5. **If the Auto Quant is enabled, use the dialog box that appears to select the quant results you wish saved.**

Choose Save to save the results and exit the dialog box.
Choose Cancel to exit the dialog box without saving the quantitative analysis results.

When processing is complete the spectra and results are placed in the ~temp directory. When you close the project, you can choose to save either the original spectra or the reprocessed spectra.
Reports and Printing

NSS provides six methods for creating reports:

- Printer report generation
- Microsoft Word file generation
- Microsoft PowerPoint file presentation
- Copy and paste reporting
- JPEG file generation
- Microsoft Excel data generation

**Printer reports**

Printer report generation is automatically set up in NSS. You can customize the items you want to appear in the report and preview the report before printing. NSS uses a Page Setup dialog box (shown below) to control the appearance (and sometimes the contents) of the generated report. When you are finished with setup, use Print Preview to view your report and Print to create a paper or .pdf copy.

To access the dialog box, choose Page Setup from the File menu.

![Page Setup Dialog Box](image)

This dialog box contains tabs for customizing the report. The tabs vary depending on the model of NSS and the options installed. The following tables describe the options on the tabs.
**Header tab** – Manages the appearance of text on each report page, and page numbering (use the Margins tab to change the font).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name, Company Name, Title</td>
<td>These fields appear on each page of the report.</td>
</tr>
<tr>
<td>Logo</td>
<td>Specify a .BMP file to appear on every page.</td>
</tr>
<tr>
<td>Logo Position</td>
<td>Enter the position of the logo as a percentage of the page width from the right margin.</td>
</tr>
<tr>
<td>Pagination</td>
<td>Select On to print the current page and total page numbers; for example, Page 1 of 3.</td>
</tr>
</tbody>
</table>

**Margins tab** – Sets the page margins and other layout parameters used for the report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top, Left, Right and Bottom</td>
<td>Margins for reports.</td>
</tr>
<tr>
<td>Label Font</td>
<td>Font for report text.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Page orientation for reports.</td>
</tr>
<tr>
<td>PPT Bk Image</td>
<td>Background image for report slides in PowerPoint. See “Generating Microsoft PowerPoint reports” later in this chapter.</td>
</tr>
<tr>
<td>PPT Resolution</td>
<td>Screen resolution for report slides in PowerPoint. See “Generating Microsoft PowerPoint reports” later in this chapter.</td>
</tr>
</tbody>
</table>
Spectra tab – Determines which spectral items appear in the report as well as their layout and color. All modes that display spectra use these settings.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select Overlaid to print all displayed spectra overlaid on a single graph.</td>
</tr>
<tr>
<td></td>
<td>Select Discrete to print each individual spectrum in a separate graph.</td>
</tr>
<tr>
<td>Layout</td>
<td>If you selected Discrete in the Type box, select the desired page layout for</td>
</tr>
<tr>
<td></td>
<td>the spectra.</td>
</tr>
<tr>
<td>Options</td>
<td>Select the optional information you want included in the report. Quant</td>
</tr>
<tr>
<td></td>
<td>results that are printed reflect the options selected on the Quant Results</td>
</tr>
<tr>
<td></td>
<td>tab of the Properties dialog box (available through Properties in the Edit</td>
</tr>
<tr>
<td></td>
<td>menu).</td>
</tr>
<tr>
<td>Color</td>
<td>Select Printer Friendly to print items using colors suited to your printer.</td>
</tr>
<tr>
<td></td>
<td>Select Screen Colors to print using the same colors that are used to</td>
</tr>
<tr>
<td></td>
<td>display the items. Select Black &amp; White to print in black and white.</td>
</tr>
</tbody>
</table>

Generating Microsoft Word reports

Microsoft Word file generation is similar to printer report generation, loading the report in Microsoft Word, where you can edit the report and save it as a Word file. Microsoft Word is included with NSS.

To generate a report for use in Microsoft Word, click the Export To Word button and then use Microsoft Word to edit, print and save the file. So long as the file is open, subsequent exports append to the report you are generating.

Generating Microsoft PowerPoint reports

Microsoft PowerPoint file generation is similar to printer report generation, loading the report in Microsoft PowerPoint, where you can edit the report and save it as a PowerPoint file. Microsoft PowerPoint is not included with NSS and must be purchased separately.

To generate a report for use in Microsoft PowerPoint, click the Export To PowerPoint button and then use Microsoft PowerPoint to edit, print and save the file. So long as the file is open, subsequent exports append to the report you are generating.

Note: The paper orientation is automatically set to landscape when you export to PowerPoint.
**Copying objects to third-party programs**

NSS can copy any of the analysis and results views to the Windows Clipboard for use in third-party programs. The format of the data depends on the currently selected pane. Quant results are copied as .csv files.

**Generating JPEG files**

JPEG file generation is also similar to copy and paste reporting, creating a .jpg file from the selected area in NSS. You can e-mail the file, publish it on a Web page or manually import it to a report.

1. **Click the view you want to copy to a JPEG file.**

   If the currently selected view is a spectrum, it is outlined on the NSS screen with a yellow box.

2. **Choose Copy To from the Edit menu.**

   The Save As dialog box appears.

3. **Select the directory in which you want to save the .jpg file.**

4. **Enter a file name.**

5. **Choose Save.**

**Directly generating Microsoft Excel data**

Microsoft Excel-compatible files (.csv) are generated by both Feature Sizing mode and batch quantitative analysis. You can copy these files from a project to another folder for use in Microsoft Excel. (Microsoft Excel is an option for purchase with NSS).
Using Feature Sizing data in Microsoft Excel

When you save data in Feature Sizing mode, the data is saved in two .csv files. One file contains particle results. The other includes frame results. Data is saved as .csv files located in a .siz subfolder of the project. Make a copy of the .csv files that you want to open in Excel. After you start Microsoft Excel, just choose Open from the File menu and select the copy of the appropriate .csv file.

Note

If you use Excel to make changes to the original Feature Sizing .csv files, these changes might be incompatible with NSS. In this case, you could be unable to review your Feature Sizing results. Always make a copy of the .csv file to use in Excel.

Using quantitative results in Microsoft Excel

Quantitative results are stored directly as a .csv file when spectra data are analyzed automatically in an analysis sequence or in a batch analysis. You will find these .csv files in the main project directory or in the ~temp directory under the main project.
Software Reference Material

**Operating system support**

U.S. versions of Microsoft Windows XP are supported for all functions of the operating systems that pertain to the operation of NSS as an x-ray microanalysis unit.

**Supported file formats**

NSS stores data in industry-standard formats whenever possible.

The following table lists the file types (by extension) used by NSS.

**Note**

All TIFF files contain both an 8-bit image and a 16-bit image. The 8-bit image is used by third-party programs such as Microsoft Word. The 16-bit image is used within NSS.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.apf</td>
<td>Automation points file.</td>
</tr>
<tr>
<td>.chem</td>
<td>Feature sizing chemical type file.</td>
</tr>
<tr>
<td>.clib</td>
<td>Feature sizing chemical library file.</td>
</tr>
<tr>
<td>.csi</td>
<td>Spectral Imaging control file. Contains the names of files used for the Spectral Imaging acquisition.</td>
</tr>
<tr>
<td>.em</td>
<td>Element map if phase data came from map input in TIFF format.</td>
</tr>
<tr>
<td>.emsa</td>
<td>Spectrum files stored in industry-standard EMSA format.</td>
</tr>
<tr>
<td>.fss</td>
<td>Feature Sizing setup file.</td>
</tr>
<tr>
<td>.fzm, .fzma or .fzme</td>
<td>Map from optional XPhase processing in TIFF format.</td>
</tr>
<tr>
<td>.fzs, .fzsa or .fzse</td>
<td>Spectrum from optional XPhase processing in EMSA format.</td>
</tr>
<tr>
<td>.grid</td>
<td>Automation grid file</td>
</tr>
<tr>
<td>.jpg</td>
<td>Image file saved in JPEG format (Edit &gt; Copy To).</td>
</tr>
<tr>
<td>.lscan</td>
<td>Linescan file.</td>
</tr>
<tr>
<td>.lsctl</td>
<td>Linescan control file.</td>
</tr>
<tr>
<td>.lsmsa</td>
<td>Spectrum files for each pixel in a linescan stored in industry-standard EMSA format.</td>
</tr>
<tr>
<td>.lsref</td>
<td>Linescan reference image in TIFF format.</td>
</tr>
</tbody>
</table>
### File Type | Description
--- | ---
.map | Element maps control file.
_map.tif | X-ray map file in TIFF format.
.mtdb | Spectral match database.
.p_s | Point & Shoot control file.
.pcm or .pcma | Compass image file in TIFF format.
.pcs or .pcsa | Compass spectrum file in EMSA format.
.psmsa | Point & Shoot spectral file in EMSA format.
.psref | Point & Shoot reference image in TIFF format.
.ref | User-defined standardless reference spectrum file in EMSA format.
.si | Spectral Imaging data file.
.simcs | Spectral Imaging concurrent external input map file in TIFF format.
.siref | Spectral Imaging reference image file in TIFF format.
.sitif | Spectral Imaging concurrent video image file in TIFF format.
.std | EDS standards spectral data file stored in EMSA format.
.stn | Standards reference list file.
.tif | Image file in TIFF format.
.tnp | NSS project template file.
.wstd | WDS standards spectral data file stored in EMSA format.

---

**More about projects and templates**

All data is stored within projects. Each project can consist of several subprojects. A project includes the elements list, identification configuration, base file name, and acquisition properties from the project’s previous use. When you start NSS, Project Explorer appears allowing you to select or create a project.

You have the ability to save a project’s settings as a project template. Templates store your project information (acquisition parameters, periodic table settings, etc.) so that you can recall and associate them with other projects. You can also save a project’s settings as a project template and apply it to other projects.
The template consists of the acquisition properties, periodic table settings, including the history, and the spectrum processing setup. Templates are stored with a .TNP extension.

**Project folders**

Each project consists of a main project folder containing all the data for the project. A project includes all setup information and data associated with the project, such as the elements list, identification configuration, base file, and acquisition properties.

When you acquire new data, it is saved in the current project’s temporary folder and follows the project’s settings. When you create a child project under a parent project, the child project inherits all of the parent project’s settings.

When you close a project or exit the software, you are asked whether to permanently save any unsaved data with the current project. If you choose to save a file with the project, the file is moved from the project’s temporary folder to the main project folder.

If you are working with data stored in the temporary folder (not yet saved in a project) and experience a power failure, the data will be in the temporary folder when you restart NSS.
Creating a new project

Follow these steps to create a new project:

1. **Click the Project Explorer button 📖 or choose Project Explorer from the File menu.**

   Project Explorer appears:

   ![Project Explorer window](image)

   Project folders appear in green. Project data is entered in the fields on the Properties tab.

   **Note**

   You must map your network’s shared resources to drive letters before you can use those locations to open and save project files or store acquired images. This applies to data, spectra, images and other NSS files. Please see your operating system documentation for information on mapping network drives. ▲

2. **Select the folder where you want to create the project folder.**

3. **Create a new folder by right-clicking the parent folder and choosing New Project from the pop-up menu.**

   A New Project folder is created.

4. **Right-click the new folder, choose Rename from the pop-up menu, and enter the appropriate project name.**

   You can also click the folder, press the F2 key and enter the name.
5. **Enter the project information.**

The following table explains how to enter information in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
<td>Select the author’s name from the drop-down list box or enter a new author’s name.</td>
</tr>
<tr>
<td>Key Words</td>
<td>Select or enter any keywords you want associated with the project. Keywords are searchable.</td>
</tr>
<tr>
<td>Client</td>
<td>Select or enter the client name.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Select or enter the due date.</td>
</tr>
<tr>
<td>Project Template</td>
<td>Select the project template from those existing in the System SIX Project Templates directory.</td>
</tr>
<tr>
<td>Notes</td>
<td>Enter any relevant notes.</td>
</tr>
</tbody>
</table>

6. **Choose OK.**

The project folder is created under the folder you selected. The name of the active project appears in the title bar.

**Note**
You can also use New Folder in the File menu of Project Explorer to create new folders that are not considered projects. ▲

**Opening a project**

Follow these steps to open an existing project:

1. **Click the Project Explorer button 📉 or choose Project Explorer from the File menu.**

   If any other files are open, the software prompts you to save or delete the data.

2. **Open the desired project.**

   If you know the project folder’s location, navigate to the folder, click it and choose OK.

   If you do not know the project’s location, right-click the parent folder and choose Project Search. Enter a keyword or select one from the
drop-down list. Choose OK. The project folders that include that keyword are marked with a red tag. Click the desired folder and choose OK.

When the project is opened, its name appears in the title bar.

**Note** In additional to managing your data in projects, you have the ability to assign a base file name for your data before acquisitions. In the file name pane, you can change the default base name to something more specific to your application. ▲

**Importing a file** You can import a file from another project into the project you have open. Import files using Open in the File menu.

To import a file using Open in the File menu:

1. **Go to the mode that corresponds to the file type.**

2. **Choose Open from the File menu.**

   The Open dialog box appears.

3. **Navigate to the directory that contains the file.**

4. **Double-click the file, or click the file and then choose Open.**

   The imported data is copied into the current project’s temporary folder and inherits the current project’s settings. To permanently save the file in the project, click the Save button on the NSS toolbar or choose Save from the File menu.

When you close the project or exit the software, you are asked whether to permanently save any unsaved data with the current project.
Creating a new project template

Templates store your project information (acquisition parameters, periodic table settings, etc.) so that you can recall and associate them with other projects.

To save the current project settings as a new template:

1. **Choose Create Template From Project from the File menu.**

2. **Navigate to the folder where you want to save the new template.**

   **Note**
   Only those templates stored in the System SIX Project Templates directory will be visible when you create a new project.

3. **Enter the name of the new template.**

4. **Choose Save.**

   The acquisition properties, periodic table settings with the history, spectrum processing setup, and Feature Sizing parameters are saved in the template. The new template is stored with a .tnp extension.

Project and system security

Use System Security in the File menu to prevent unauthorized modification of project templates, acquisition properties and service views. This feature lets you protect templates with a password, specify which functions are protected, and remove password protection.

By default, all security is turned off. The computer is set up with the user name “Thermo Scientific” and no password (choose OK with no password). Additional users and passwords may be added at your discretion—consult your Windows documentation.

To protect projects and system configurations:

1. **Choose System Security from the File menu and then choose Lock Systems.**
2. When the lock Projects dialog appears, enter the password to lock the system.

To change the behavior when the system is locked:

1. Choose System Security from the File menu and then choose Security Setup from the expanded menu.

If a password is installed, enter the password when you are prompted.

2. When the System Security Setup dialog appears, select the items you wish to lock.

A check next to the item indicates the item will be locked.
3. If you wish to password protect the locked items, enter an administrator password in the New Password text box.

4. Enter the password a second time in the Confirm New Password text box.

5. Choose OK exit the dialog box and lock the items you selected.

Choose Cancel to exit the dialog box without changing the security settings.

To turn off protection:

1. Point to System Security in the File menu, and then choose Unlock.

The Unlock Projects dialog box appears:

![Unlock Projects dialog box]

2. Enter the administrator password and choose OK.

![Unlock Projects confirmation]

3. Choose OK.

Resetting a project to the original template settings

Resetting a project restores the template settings for that project.

To reset a project, choose Reset Project from the Edit menu.
Any changes to the settings are restored to the settings for the original template used for the project.

**Note**

If the template settings have changed in the time between when the project was created and the time the project was reset, the project will be reset to the original template’s current settings. ▲

---

**Searching for project keywords**

You can search project folders to find keywords associated with one or more projects containing the keyword.

To search for a project keyword:

1. **Click the Project Explorer button** or choose *Project Explorer from the File menu.*

2. **Right-click a folder.**

   Projects at or below this folder will be searched.

3. **Choose Project Search from the pop-up menu.**

4. **When the dialog box appears, type a full or partial keyword.**

   The highlight moves in Key Words drop-down list box to the word you typed. Choose OK to begin the search.

   If the word you typed is not a keyword, the nearest similar keyword is highlighted. If it is an appropriate alternative, choose OK to begin the search. If it is not, browse through the list to find an appropriate keyword.

   Folders containing the keyword are marked with a red tab.

---

**Menu commands**

The availability of menus and the commands they contain may depend on the current mode and view, whether a displayed item is selected, which options are installed, and which NSS model you have. The sections below describe what you can do with each command when it is available.
## File menu

File menu commands include:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Explorer</td>
<td>Open, create or edit a project.</td>
</tr>
<tr>
<td>Close Project</td>
<td>Close the current project.</td>
</tr>
<tr>
<td>Create Template From Project</td>
<td>Create a template from the current project to use when creating projects with the same initial parameter settings.</td>
</tr>
<tr>
<td>System Security</td>
<td>Prevent unauthorized modification of project templates or remove the protection.</td>
</tr>
<tr>
<td>Open</td>
<td>Open a file stored in a location other than the current project folder.</td>
</tr>
<tr>
<td>Close</td>
<td>Close the current file.</td>
</tr>
<tr>
<td>Save</td>
<td>Save the current file with its current file name.</td>
</tr>
<tr>
<td>Save Map File</td>
<td>Save the current elemental maps as a unit. Available only in Spectral Imaging mode.</td>
</tr>
<tr>
<td>Export Image As CSV</td>
<td>Save an image or a map as a simple text file.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Specify how to print information.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>See how information will appear when printed.</td>
</tr>
<tr>
<td>Print</td>
<td>Print the specified report.</td>
</tr>
<tr>
<td>Export To Word</td>
<td>Place the specified report in a new or current Microsoft Word document.</td>
</tr>
<tr>
<td>Export To PowerPoint</td>
<td>Place the specified report in a new or current Microsoft PowerPoint presentation.</td>
</tr>
<tr>
<td>Compress SI File</td>
<td>Greatly reduce the size of a Spectral Imaging data set.</td>
</tr>
<tr>
<td>Exit</td>
<td>Close NSS.</td>
</tr>
</tbody>
</table>
**Edit menu**

Edit menu commands include:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Reverse the effects of the previous action.</td>
</tr>
<tr>
<td>Cut</td>
<td>Delete the selected item and place it on the Windows Clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected item to the Windows Clipboard.</td>
</tr>
<tr>
<td>Copy To…</td>
<td>Saves the currently selected pane to a *.jpg file.</td>
</tr>
<tr>
<td>Paste</td>
<td>Place a copy of the contents of the Windows Clipboard in the specified location.</td>
</tr>
<tr>
<td>Acquisition Properties</td>
<td>Set parameters affecting data acquisition.</td>
</tr>
<tr>
<td>Microscope Parameters</td>
<td>Set parameters affecting microscope operation and specify items to display in the status bar.</td>
</tr>
<tr>
<td>Properties</td>
<td>Set parameters affecting specific mode properties.</td>
</tr>
<tr>
<td>Reset Project</td>
<td>Restore the current project to its template settings.</td>
</tr>
<tr>
<td>Language</td>
<td>Select the language for use with NSS.</td>
</tr>
</tbody>
</table>

**View menu**

View menu commands include:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Toolbars</td>
<td>Recall all toolbars, including any that you closed.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Toggle the display of the status bar at the bottom of the screen.</td>
</tr>
</tbody>
</table>

**Batch Processing menu**

Batch Processing menu commands include:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quant Analysis</td>
<td>Automatically quantify a selected series of spectra in the current project.</td>
</tr>
</tbody>
</table>
Help menu

Help menu commands include:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Find information about software features.</td>
</tr>
<tr>
<td>What’s This?</td>
<td>Display a special pointer that you can use to click features to display information about them.</td>
</tr>
<tr>
<td>About NSS</td>
<td>Display the version number and other information about your copy of the software.</td>
</tr>
</tbody>
</table>

Installing the software

This section explains how to install and uninstall NSS software.

Note
If you are reinstalling NSS software, either as an upgrade or if you have purchased new options (new license key), first uninstall the existing NSS software as explained later in this section. ▲

To install NSS software:

1. **Insert the NSS installation CD.**

   The installation program starts automatically.

   **Note**
   If the installation program does not start automatically, reinsert the installation CD or navigate to the CD-ROM drive and double-click the file named Setup.exe. ▲

2. **Follow the on-screen instructions.**

   In the Customer Information screen, enter a user name, company name and your license key. The license key is a 24-digit code shipped with your system. Choose Next and continue with the on-screen instructions.

   Choose Finish when the installation is complete.
To uninstall NSS software:

1. **Open the Add Or Remove Programs window.**
   
   See your Windows documentation if you are unfamiliar with adding and removing programs.

2. **Select NSS.**

3. **Choose Change/Remove.**

4. **Follow the on-screen instructions.**
   
   Choose Finish when the uninstall is complete.

---

**Enabling roaming user accounts**

If a network user (roaming user) cannot open or acquire data, the user might not have the correct rights.

If a user with a network account wants to log on to the NSS computer using his or her network account, the system administrator must make the following changes to the user’s network account on the network server (not the local NSS computer).

To enable the roaming user to access data on the NSS computer:

- Increase scheduling priority.
- Lock pages in memory.

To give the user the correct rights:

1. **In Windows, go to User Rights Assignments.**
   
   Start > Control Panel > Administrative Tools > Local Security Policy > Local Policies > User Rights Assignments

2. **Scroll down the list of rights to Increase Scheduling Priority.**
3. Double-click the entry to display the Add Users And Groups dialog box, click the name and then choose Add.

4. Scroll down the list of rights to Lock Pages In Memory.

5. Double-click the entry to display the Add Users And Groups dialog box, click the name and then choose Add.

6. **Confirm that the user rights are correct.**

   Scroll through the list of rights for Increase Quota, Increase Scheduling Priority and Lock Pages In Memory. In each case, the user’s name should appear in the Grant To box.

---

**Screen appearance**

NSS allows you to customize the appearance on-screen, window sizes, and toolbar locations for convenience and better viewing.

**Changing the size of window panes**

To change the size of window panes, move the cursor to a border. When the arrows appear, drag until the window is sized as you like.
Rearranging, removing and restoring toolbars

You can dock toolbars on the top or either side of the NSS window for move convenient access…

or have it float over the panes in a tool palette…

To move a toolbar, drag the toolbar by its handle or the palette title to the new location.

To return a floating toolbar to its previous edge position, double-click the toolbar’s title bar.

You can remove a floating toolbar from the screen by clicking the button labeled “X” in the upper-right corner of the toolbar’s window. To restore a removed toolbar, choose Restore Toolbars from the View menu.

Saving your rearranged screen

When you exit NSS, the toolbar positions and window pane sizes are saved. The next time you start the software, the screen is arranged as it was when you last exited.

Screen resolution and color

NSS is designed for a screen resolution of 1024 x 768 or larger. See the documentation that came with your computer if you are unfamiliar with setting screen resolution and color. For best viewing, maximize the NSS window.
Detector status

To view the detector status while in Spectrum mode, click the Detector Status tab in the bottom-right pane. This tab displays the current PHA status and times for the detector. These values are constantly updated. The zero histogram centroid is used to keep the spectrum offset correct. The measured distribution of the zero strobe (zero histogram) indicates how well the detector is performing. Detectors for a specified resolution expect a specific zero histogram. If it is too wide, the detector might not be functioning properly.

The next section explains how to use the Advanced Status button to view additional detector status information.
To see more detailed information about the status of the detector, click the Advanced Status button to display the FrontEnd Status dialog box. Here is an example for a single-detector system:

![FrontEnd Status dialog box]

You can use the information in this dialog box to monitor detector operation and diagnosis detector problems. If the system has two detectors, two separate sets of values are displayed—one for each of the two pulse processor subsystems. On single-detector systems the second set of values is dimmed, as in the example above.

The full version string from the embedded software running on the chassis in `<Major>`.`<Minor>`.`<Build>` notation. `<Build>` corresponds to the “Analyzer Build” number displayed in the title bar. The version can be useful in tracking known or new problems with a specific version of the embedded software.

The features in the FrontEnd Status dialog box are explained in detail in the next sections.
### Acquisition Parameters/Values

The information in the Acquisition Parameters/Values box indicates the status of the detector and digital pulse processor (DPP) as well as the chassis and detector temperatures:

<table>
<thead>
<tr>
<th>Feature(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detects/sec, Converts/sec, Stores/sec, %</td>
<td>These values are averaged and updated simultaneously using a sliding half-second window. They are interrelated and indicate the number of x-ray energy events the detector is presenting to the DPP and how many of those raw events are converted into usable energy events at the output of the DPP. These values are affected by the beam current, the time constant, the sample being scanned and other factors.</td>
</tr>
<tr>
<td>Dead Time</td>
<td>A sliding sum representing the number of resets per second that the detector is experiencing. An abnormally high reading can indicate that the detector crystal is warm or that the FET (field effect transistor) is bad. (There may also be a large number of resets in a TEM when the grid bar is crossed.) If the reading exceeds a calibrated threshold, the detector bias automatically turns off to protect the crystal. If this occurs, the corresponding Bias On status LED (described below) changes to show that the bias is disabled.</td>
</tr>
<tr>
<td>Resets/sec</td>
<td>The maximum energy range of the spectra being collected for the current acquisition. In conjunction with the eV/Channel value (described below), this value indicates the number of channels in the MCA array. For example, if the energy range is from 0 to 10 keV and the eV/Channel value is 10, the MCA array contains 1024 bins.</td>
</tr>
<tr>
<td>Energy Range (keV)</td>
<td>The time constant being used by the DPP for the current acquisition.</td>
</tr>
<tr>
<td>Time Constant (μs)</td>
<td>The discriminator value being used by the DPP for the current acquisition.</td>
</tr>
<tr>
<td>Discriminator</td>
<td>The “width” of each channel in the MCA array. Together with the Energy Range (keV) value (described above), this value indicates the number of channels in the MCA array. For example, if the energy range is from 0 to 10 keV and the eV/Channel value is 10, the MCA array contains 1024 bins.</td>
</tr>
<tr>
<td>eV/Channel</td>
<td>The fine gain calibration value for the current time constant. A separate fine gain value is stored for each available time constant. The fine gain calibration values are stored in the registry on the host (that is, not in the calibration file on the chassis), and the host updates the chassis each time a new time constant is selected. The initial value is 32500. This value is modified when EDS Fine Grain Calibration is run from NSS.</td>
</tr>
</tbody>
</table>
### Feature(s)

<table>
<thead>
<tr>
<th>Feature(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero FWHM (eV)</td>
<td>A filtered and averaged value indicating the current Full Width Half Maximum (FWHM) value of the zero peak. This value reflects baseline noise and ultimately the resolution of the system.</td>
</tr>
<tr>
<td>Chassis Temperature (°C)</td>
<td>The current temperature in degrees Celsius at the thermocouple on the EDS board in the chassis. The reading should be around 30 to 32 degrees Celsius after the chassis has been powered up and running for some time.</td>
</tr>
<tr>
<td>Detector Temperature (K), Detector Temperature (mV)</td>
<td>The first value indicates the approximate detector temperature in degrees Kelvin. The chassis has conversion functions to go from mV to K for those detectors with temperature sensors that support it. Note that although the conversion functions are accurate to within roughly ± 5 °K within the operating range, some inaccuracies are unaccounted for (such as the coupling of the detector to the stack, manufacturing differences from sensor to sensor, etc.). Consequently, the temperature at the crystal varies somewhat from the temperature displayed here. If the conversion from voltage to temperature results in a negative value, “Error” appears. This should happen only if the temperature sensor circuit has failed (that is, an open circuit). Note that some detectors do not support direct readout of temperature (such as a liquid nitrogen-cooled detector using the dipstick to monitor the liquid nitrogen level). For these detectors, these features are dimmed and display “N/A.”</td>
</tr>
<tr>
<td>Detector Bias Voltage(V)</td>
<td>This value is the actual bias voltage being generated by the chassis. The bias required for a SiLi detector is printed on the detector serial number label. This reading will be approximately 0 volts for an UltraDry detector since the bias is supplied by the support box.</td>
</tr>
</tbody>
</table>

### Diagnostic message history

The large pane in the FrontEnd Status dialog box displays a scrolling log of the diagnostic error messages emanating from the chassis. Here is an example:

```plaintext
0 pcisInit [99] Found PLY Units with device 32
1 NoranPCIConfig [99] New Local Memory Config = 0x00000000
2 NoranPCIConfig [99] New Local Address Space1 = 0x00000000
3 NoranPCIConfig [99] New Local Address Space1 = 0x00000000
4 NoranPCIConfig [99] New Local Address Space2 = 0x00000000
5 NoranPCIConfig [99] New Local Address Space3 = 0x00000000
6 NoranPCIConfig [99] New IRQ = 0x0
7 usrCopyInit [99] /etc/ successfully mounted,FLASH_ROOT
8 flashGetString [99] /etc/ports.dat could not be opened, SubnetMask not read
9 apvStartup [99] Subnet mask = 255.255.255.0 ; OxFFFFFF00
10 flashGetString [99] /etc/ports.dat could not be opened, IPAddress not read
11 apvStartup [99] IP Address set to 10.0.0.50
12 edaStartup [105] EDS subsystem 1 successfully started
13 edaBiasOn [1000] Bias turned ON...
14 msgMessage [999] MFE_ABORT, Error shutting down subsystem: code = 2
```

Logging Level | Warning | Echo All Commands | Pause | One Log | Save Log to File...
To pause the message log (if the messages are streaming too quickly), click the Pause button.

**Notice**  While the log is paused, any messages sent by the chassis are lost.

To clear the log (to delete extraneous information), click the Clear Log button.

To save the log in a file for later review, click the Save Log To File button. In the dialog box that appears, specify a file name and location and then choose Save.

From the point that the embedded software on the chassis starts until it is turned off or a fatal error is encountered, the software is constantly monitoring the state of the chassis. These messages are grouped into three different log levels of increasing severity (and decreasing verbosity):

1. Info (Verbose)
2. Warning (default setting)
3. Errors Only
Each log level displays its own level of messages as well as those from the lower verbosity settings (for example, in Info mode the chassis also displays both Warning and Errors Only messages). Select the desired level from the Logging Level drop-down list box.

**Info** messages are positioned rather liberally throughout the code to give a more complete picture of the chassis state transitions as well as the message passing between the host application and the chassis. When the chassis is in Info mode, the sheer number of APV messages being sent by the chassis can disrupt the timing of an acquisition running on the chassis. Therefore, you should place the chassis in Info mode only when diagnosing a specific problem. After you collect the desired information, either cycle the chassis power or place the chassis back in Warning mode.

**Warning** messages are typically displayed when the chassis encounters a recoverable error. Also, some messages are logged at the Warning level by the software developers to aid in understanding the state transitions of the chassis and its current operating mode. Receiving a Warning message is not by itself a cause for concern; you must read the message to determine whether it was intended as a true warning or merely a diagnostic aid.

**Errors Only** messages are considered fatal errors; that is, the chassis is in an unrecoverable state, and the power must be cycled before acquisition can resume.

The Echo All Commands option provides the lengthiest output of all. When this option is selected, the chassis echoes every command it receives from host applications—including requests sent by the FrontEnd Status utility to update its own display. The commands are echoed immediately upon receipt and before the chassis acts. This can be useful for troubleshooting in situations where even Info mode does not provide sufficient information. However, placing the chassis in this mode consumes a lot of network and processing bandwidth on the chassis and disrupts timing. Therefore, you should select this option only in rare circumstances that require it and should never leave the chassis in this mode after the information is collected.
Status LEDs  
The Status LEDs box displays the EDS status parameters as a series of LEDs whose color indicates the current status:

![Status LEDs diagram](image)

The parameters containing the time-averaged raw voltages of the chassis’ power supply and the derived voltages on the EDS board are monitored to ensure that they are in range, and their state is displayed by the last two LEDs. These are described in the table at the end of this section.

The EDS subsystem in the chassis has a status parameter that is continually monitored by the host software. This status parameter is a bit mask with the bits assigned to two groups of information: Error and Diagnostic Flags, and Acquisition State. The Error and Diagnostic Flags are displayed in red if the respective bit is set, and black if the respective bit is cleared. The Acquisition State bits are displayed in green if set and red if cleared.

The Error and Diagnostic Flags parameters are described in the following table.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low LN</td>
<td>Active only for LN detectors with a dipstick. In this case, the LNSENSE signal on the EDS board is an output, biased with 5 V by the chassis. The chassis continually compares the LNSENSE signal with the “High voltage temperature threshold” as set during detector calibration. If the measured voltage is above the threshold voltage, this bit is set and the “time to off” timer is started. If the timeout is reached without the voltage (that is, temperature) returning below the threshold, the Warm Detector bit is set and bias is disabled. The “time to off” can be zero if the sensor is mounted in close thermal proximity to the crystal (cryogenic detectors).</td>
</tr>
<tr>
<td>High Reset Rate</td>
<td>Set if the Resets/sec count exceeds the threshold set during detector calibration (typically 5000/sec). In addition to flagging the High Reset Rate warning, the chassis also simultaneously disables the bias current to avoid detector crystal damage. After “Reset Time 2” tenths of a second, the bias is reapplied and the reset rate is measured again. If the Resets/sec count returns to below the threshold, the bias remains applied. If not, the bias is disabled and the cycle starts anew.</td>
</tr>
<tr>
<td>Warm Detector</td>
<td>Active for LN detectors with a dipstick and for LN detectors with a stack sensor.</td>
</tr>
<tr>
<td></td>
<td>For LN detectors with a dipstick, the bit is set after the voltage rises above the DPPCal threshold and stays there for the “time to off” period as described above for the Low LN bit.</td>
</tr>
<tr>
<td></td>
<td>For LN detectors with a stack sensor, the LNSENSE line is an input. The chassis continually compares the LNSENSE signal to the “High voltage stack temp threshold” as set during detector calibration. If the voltage rises above the threshold (positive slope) or falls below the threshold (negative slope), this bit is set. In addition to setting the bit, the chassis simultaneously and immediately disables the bias voltage to avoid detector crystal damage.</td>
</tr>
<tr>
<td>Validation Error</td>
<td>The chassis maintains numerous variables that the host sets to constrain an acquisition. Before activating the variables, the chassis error checks the variables to ensure they are within bounds and otherwise contain allowed values. If they do not, the Validation Error bit is set. Since it is normal for this bit to be set during normal operation of the chassis and EDS application, it cannot be used alone to diagnose problems.</td>
</tr>
<tr>
<td>Hardware Failure</td>
<td>This is currently unused.</td>
</tr>
</tbody>
</table>
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Dead Time</td>
<td>Set when high dead time (greater than 95%) is encountered by the DPP.</td>
</tr>
<tr>
<td>Bias On</td>
<td>Set when the chassis enables the bias voltage, and cleared when the bias voltage is disabled. This will always be off with an UltraDry detector since the bias is supplied by the support box.</td>
</tr>
<tr>
<td>Diagnostic</td>
<td>This is currently unused.</td>
</tr>
</tbody>
</table>

The Acquisition State parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Set when an acquisition is in progress. Both the Starting and Active bits (described below) are set at the beginning of an acquisition. The Starting bit is cleared to indicate that any setup steps are complete and data is being gathered. Both bits are set at the end of an acquisition (when the termination conditions have been met) and cleared when the acquisition has terminated cleanly.</td>
</tr>
<tr>
<td>Downloading</td>
<td>Set to indicate that new parameters (such as Time Constant) have been downloaded to the DSPs that make up the DPP.</td>
</tr>
<tr>
<td>Starting</td>
<td>Set to indicate that an acquisition is starting. Both the Starting bit and Active bit (described above) are set at the beginning of an acquisition. The Starting bit is cleared to indicate that the acquisition setup is complete and data is being gathered.</td>
</tr>
<tr>
<td>Stopping</td>
<td>Set to indicate that an acquisition has met its termination conditions and is in the process of stopping. Both the Stopping bit and Active bit (described above) are simultaneously set at the end of a normal acquisition. Both bits are cleared when the acquisition has terminated cleanly.</td>
</tr>
</tbody>
</table>
The power supply parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDS Power Supply</td>
<td>If all EDS power supply values are within their normal ranges, the LED appears green. If any value is outside its normal range, the LED appears red.</td>
</tr>
<tr>
<td>Power Supply</td>
<td>If all power supply values are within their normal ranges, the LED appears green. If any value is outside its normal range, the LED appears red.</td>
</tr>
</tbody>
</table>

**Connectivity and control**

The features at the bottom of the FrontEnd Status dialog box display information about connectivity with the chassis and let you control the application:

When the FrontEnd Status utility starts, it attempts to connect to the chassis. The IP address used is the one set by IP Address in the Hardware Communications box in Instrument Configuration mode under Service. This address is stored in the registry on the Windows host. If a registry entry is not present, the default IP address is used: 90.0.0.50.

The IP address that FrontEnd Status is attempting to connect to is displayed in the lower-left corner of the dialog box alongside the connectivity LED. When a good connection is established, the connectivity LED appears green. When a connection is not established, the LED appears red. If a connection is dropped (or was never successfully achieved), you must manually reconnect by clicking the Reconnect button after the problem with the chassis or Ethernet cabling has been resolved.

When you are troubleshooting, it is often useful to reset the chassis to start from a known quiescent and clean state. As an alternative to cycling the power, you can use the Reboot button to cleanly reboot the chassis. Choosing Reboot sends a “reboot” message to the chassis, resulting in a hardware reset being asserted internal to the chassis and a complete software reboot. For most purposes this gives the same results as a power cycle. However, the “reboot” does involve software control. If the embedded software image has become corrupted in RAM or the software is otherwise not responding (that is, if a fatal error is detected), you may need to cycle the power.

To cleanly exit the FrontEnd Status utility, click the Close button.
**EDS Calibration**

NSS systems are installed and calibrated by a factory trained FSE. Periodically it is recommended that the Fine Gain calibration be performed.

**Fine Gain calibration procedure**

The Fine Gain calibration should be used to make final corrections to the Fine Gain value. There are actually several Time Constants that need to be calibrated. The procedure below runs through one of them. For each pass through the procedure select a different Time Constant in step 4 until the fine gain for all of the Time Constants are calibrated.

1. **Click the Auto tab in lower right corner of the EDS Calibration mode to display the Fine Gain calibration settings.**
2. Position the stage to a pure standard sample in the microscope.

Pure copper is recommended for performing the Fine Gain calibration. Use the following microscope conditions:

- Optimum working distance per installation documentation.
- Minimum accelerating voltage of 20 kV.
- Obtain a store rate of approximately 4000cps.

3. In the Setup section of the window, select Cu from the element chart, K as the Line, and 30 for Maximum Iterations using the pull-down selections.

4. Select a Time Constant from the drop down selections.

5. Click the Play button to start the calibration.

A spectrum will be acquired.


Place the cursor on the centroid of the Cu Ka peak in the display and click the OK button to continue with the calibration.

The Calibration program automatically moves the selected peak to the proper energy value for the element that was chosen in step 3.
7. A prompt displays stating that Calibration completed successfully. Click the OK button to finish.

The new Fine Gain setting and the Calibration Date will be updated in the status section in the lower right hand corner of the Auto tab.

8. Repeat steps 4 - 7 to calibrate the Fine Gain for all available Time Constants.
Index

A
A factor, 63
absorption correction in quantitative analysis results, 63
acquiring
   spectrum, 22
   WDS elements, 23
acquisition properties, 12, 22
Acquisition Properties command, 12, 22, 93
Acquisition toolbar, 10
adding
   regions of interest, 33
advanced detector status, 99
always identified element, 36
Analysis Automation
   analysis controls pane, 8
Analysis Setup tab, 40
apf file type, 82
applications, 2
atomic percentage, 63
atomic-number correction in quantitative analysis results, 63
Auto ID, 41
automatic identifications and analyses, 41
Cliff-Lorimer Without Absorbance correction, 59
Close command, 92
Close Project command, 92
color
   for printing report, 79
   screen, 97
column, 13
cOMPANY NAME IN REPORT, 78
Compare Information tab, 25
comparing spectra, 25
Compass
   image file type, 83
   spectrum file type, 83
component map
   copying, 80
compound percentage, 63
Compress SI File command, 92
Compress Spectrum button, 16
compressing
   spectrum, 16
Copy command, 93
Copy To command, 80, 93
copying objects to third-party programs, 80
correction
   matrix, 59
counts, 33
   in quantitative analysis results, 62
   number of, 23
Create Template From Project command, 88, 92
csi file type, 82
current
   beam, 24
Cut command, 93

B
background, 25
   ratioing peak to, 33
background image for PowerPoint report, 78
Batch Processing menu commands, 93
beam current, 24
bias voltage, 106

c
 calibration factor, 71
cations, 63
Change To Log Mode button, 17
cchannel
   width, 100
chassis
   connectivity, 107
   power supply voltages, 104
   temperature, 101
chem file type, 82
chemical formula
   in quantitative analysis results, 63
chi-square cutoff, 55
clearing peak identification results, 39
clib file type, 82
Cliff-Lorimer With Absorbance correction, 60
data management, 83
data saved in temporary folder, 84
data set
   labeling, 19
database
   searching, 55
dead time, 100, 106
Decrease Y Scale button, 16
detector, 4
   parameters, 22
   selecting, 11
   status, 98, 99, 100
temperature, 101
   warm, 105
E

Edit Acquisition Properties button, 12, 22
Edit menu commands, 93
Edit Microscope Parameters button, 13
editing
  peak label, 48
EDS 2 tab, 22
EDS board voltages, 104
EDS power supply, 107
EDS status parameters, 104
EDS tab, 22
electron image
copying, 80
file type, 82
element
  adding labels for, 49
  excluding
    from peak identification, 39
    from quantitative results, 39
  finding at peak, 46
  for comparing spectra, 26
  for spectrum acquisition, 23
  locating, 43
  map, 41
  ratioing, 65
  specifying for analysis, 36
  weight percentage, 65
  x-ray line energies for, 46
element map
  file type, 82
Element Setup tab, 35
Element X-Ray Lines command, 46
elements
  for analysis, 35
Elements toolbar, 11
em file type, 82
e-mail address, 2
essma file type, 82
enabling roaming user accounts, 95
energy cursor, 51
Energy Cursor On/Off button, 51
energy cutoff, 23
energy range, 100
  for comparing spectra, 26
  standard, 71
error in quantitative analysis results, 62
error messages, 101
Ethernet, 4
eV value for spectrum acquisition, 23
Excel
  using Feature Sizing data in, 81
  using quantitative analysis results in, 81
excluded element, 36
excluding element
  from peak identification, 39
  from quantitative results, 39
Exit command, 92
exiting software
  saving rearranged screen when, 97
Expand Spectrum button, 16
expanding
  peak, 17
  spectrum, 16
Export Image As CSV command, 92
Export To PowerPoint command, 92
Export To Word command, 92
exporting
  report
    to PowerPoint, 79
    to Word, 79
extensions, 19
F
F factor, 63
fax number, 2
Feature Sizing
  setup file type, 82
  using data from in Excel, 81
file formats, 19
file list pane, 8
File menu commands, 92
file name, 8
  affected by labeling, 19
file name pane, 8
Filter With Standards method, 59
Filter Without Standards method, 58
fine grain calibration, 100
fit methods, 58
floating toolbar, 97
fluorescence correction in quantitative analysis results, 63
folder for project, 84
font, 78
fss file type, 82
fuses, 5
fzm file type, 82
fzma file type, 82
fzme file type, 82
fzs file type, 82
fzsa file type, 82
fsez file type, 82

Detector Selector toolbar, 11
diagnostics
  history, 101
digital pulse processor
  status, 100
discriminator, 100
dividing regions of interest, 33

Ethernet, 4
eV value for spectrum acquisition, 23
Excel
  using Feature Sizing data in, 81
  using quantitative analysis results in, 81
excluded element, 36
excluding element
  from peak identification, 39
  from quantitative results, 39
Exit command, 92
exiting software
  saving rearranged screen when, 97
Expand Spectrum button, 16
expanding
  peak, 17
  spectrum, 16
Export Image As CSV command, 92
Export To PowerPoint command, 92
Export To Word command, 92
exporting
  report
    to PowerPoint, 79
    to Word, 79
extensions, 19

F factor, 63
fax number, 2
Feature Sizing
  setup file type, 82
  using data from in Excel, 81
file formats, 19
file list pane, 8
File menu commands, 92
file name, 8
  affected by labeling, 19
file name pane, 8
Filter With Standards method, 59
Filter Without Standards method, 58
fine grain calibration, 100
fit methods, 58
floating toolbar, 97
fluorescence correction in quantitative analysis results, 63
folder for project, 84
font, 78
fss file type, 82
fuses, 5
fzm file type, 82
fzma file type, 82
fzme file type, 82
fzs file type, 82
fzsa file type, 82
fsez file type, 82

Detector Selector toolbar, 11
diagnostics
  history, 101
digital pulse processor
  status, 100
discriminator, 100
dividing regions of interest, 33

Ethernet, 4
eV value for spectrum acquisition, 23
Excel
  using Feature Sizing data in, 81
  using quantitative analysis results in, 81
excluded element, 36
excluding element
  from peak identification, 39
  from quantitative results, 39
Exit command, 92
exiting software
  saving rearranged screen when, 97
Expand Spectrum button, 16
expanding
  peak, 17
  spectrum, 16
Export Image As CSV command, 92
Export To PowerPoint command, 92
Export To Word command, 92
exporting
  report
    to PowerPoint, 79
    to Word, 79
extensions, 19

F factor, 63
fax number, 2
Feature Sizing
  setup file type, 82
  using data from in Excel, 81
file formats, 19
file list pane, 8
File menu commands, 92
file name, 8
  affected by labeling, 19
file name pane, 8
Filter With Standards method, 59
Filter Without Standards method, 58
fine grain calibration, 100
fit methods, 58
floating toolbar, 97
fluorescence correction in quantitative analysis results, 63
folder for project, 84
font, 78
fss file type, 82
fuses, 5
fzm file type, 82
fzma file type, 82
fzme file type, 82
fzs file type, 82
fzsa file type, 82
fsez file type, 82

Detector Selector toolbar, 11
diagnostics
  history, 101
digital pulse processor
  status, 100
discriminator, 100
dividing regions of interest, 33

Ethernet, 4
eV value for spectrum acquisition, 23
Excel
  using Feature Sizing data in, 81
  using quantitative analysis results in, 81
excluded element, 36
excluding element
  from peak identification, 39
  from quantitative results, 39
Exit command, 92
exiting software
  saving rearranged screen when, 97
Expand Spectrum button, 16
expanding
  peak, 17
  spectrum, 16
Export Image As CSV command, 92
Export To PowerPoint command, 92
Export To Word command, 92
exporting
  report
    to PowerPoint, 79
    to Word, 79
extensions, 19

F factor, 63
fax number, 2
Feature Sizing
  setup file type, 82
  using data from in Excel, 81
file formats, 19
file list pane, 8
File menu commands, 92
file name, 8
  affected by labeling, 19
file name pane, 8
Filter With Standards method, 59
Filter Without Standards method, 58
fine grain calibration, 100
fit methods, 58
floating toolbar, 97
fluorescence correction in quantitative analysis results, 63
folder for project, 84
font, 78
fss file type, 82
fuses, 5
fzm file type, 82
fzma file type, 82
fzme file type, 82
fzs file type, 82
fzsa file type, 82
fsez file type, 82

Detector Selector toolbar, 11
diagnostics
  history, 101
digital pulse processor
  status, 100
discriminator, 100
dividing regions of interest, 33

Ethernet, 4
eV value for spectrum acquisition, 23
Excel
  using Feature Sizing data in, 81
  using quantitative analysis results in, 81
excluded element, 36
excluding element
  from peak identification, 39
  from quantitative results, 39
Exit command, 92
exiting software
  saving rearranged screen when, 97
Expand Spectrum button, 16
expanding
  peak, 17
  spectrum, 16
Export Image As CSV command, 92
Export To PowerPoint command, 92
Export To Word command, 92
exporting
  report
    to PowerPoint, 79
    to Word, 79
extensions, 19

F factor, 63
fax number, 2
Feature Sizing
  setup file type, 82
  using data from in Excel, 81
file formats, 19
file list pane, 8
File menu commands, 92
file name, 8
  affected by labeling, 19
file name pane, 8
Filter With Standards method, 59
Filter Without Standards method, 58
fine grain calibration, 100
fit methods, 58
floating toolbar, 97
fluorescence correction in quantitative analysis results, 63
folder for project, 84
font, 78
fss file type, 82
fuses, 5
fzm file type, 82
fzma file type, 82
fzme file type, 82
fzs file type, 82
fzsa file type, 82
fsez file type, 82
G
Gaussian With Standards method, 58
Gaussian Without Standards method, 58
grid file type, 82

H
hardware components, 4
Header tab, 78
Help menu commands, 94
history
  diagnostic message, 101
history periodic table, 40

I
Ident toolbar, 11
identification
  automatic, 41
  sensitivity, 40
identified element, 36
Identify Spectrum button, 36
identifying
  peaks
    automatically, 36, 41
    manually, 43
  spectrum, 52
image
  copying, 80
  file type, 82, 83
importing file from different project, 87
inactive element, 36
Increase Y Scale button, 16
installing software, 94
intensity
  error, 62
  in quantitative analysis results, 62
IP address, 107

J
JPEG file
  image saved as, 82
  saving item as, 80
jpeg files, 93
jpg file type, 82

K
K factor, 63
keywords
  searching for, 91
KLM line for spectrum acquisition, 23
KLM lines
  displaying, 43
  finding on spectrum, 45
  scrolling with arrow keys, 44
  searching for and labeling, 50
  x-ray intensities for, 46
  KLM Lines On/Off button, 43
Kramer’s Law, 58
k-ratio
  calculating, 58
  error, 63
  in quantitative analysis results, 63

L
label
  adding for element, 49
  editing for peak, 48
  font, 78
  KLM line, 50
  peak, 51
  removing, 49
labeling
  all peaks, 48
  data set, 19
  peak, 48
language selection, 93
layout of report, 79
license key, 94
line for quantification and display, 38
linescan
  copying, 80
  file type, 82
  linescan spectrum
    file type, 82
livetime
  for comparing spectra, 26
locking project, 89
log of error messages, 101
log scale, 17
logging on, 95
logo in report, 78
ls scan file type, 82
lsctl file type, 82
lsmsa file type, 82
lsref file type, 82

M
managing
  data files, 17
map
  copying, 80
  file type, 82
map file type, 83
mapping network resources, 85
Margins tab, 78
Match command, 56
Match Results tab, 56
math operations, 28, 33
matrix
  correction, 59
maximum number of counts for spectrum acquisition, 23
menu commands, 91
microscope, 4
   beam current, 24
   properties, 13
Microscope Parameters command, 13, 93
   mode
      changing, 8
Move Spectrum Left button, 16
Move Spectrum Right button, 16
moving
   spectrum, 15
   toolbar, 97
mtdb file type, 83
multiplier for comparing spectra, 26
multiplying regions of interest, 33

N
naming spectrum, 20
navigation pane, 8
net counts, 62
New Project, 85
noise
   baseline, 101
normalized compound percentage, 63
normalized weight percentage, 63
normalizing spectrum for comparison, 26
note text, 20
NSS
   exiting, 97
   file formats, 19
   installing, 94
   overview, 3
   preparing to use, 6
   starting, 6
   uninstalling, 95
NSS toolbar, 9
NSS window, 7
   panes, 7
number of cations, 63

O
Open command, 18, 87, 92
opening
   project, 86
   spectrum, 18
operating system, 82
orientation
   printing, 78
overlaying
   spectra, 79
oxides
   adjusting for, 37

P
p_s file type, 83
page numbers in report, 78
page orientation, 78
Page Setup command, 77, 92
   panes, 7
      resizing, 96
password, 88
Paste command, 93
pcm file type, 83
pcma file type, 83
pcs file type, 83
pcsa file type, 83
peak
   finding element at, 46
   label, 51
   labeling, 48, 49
   ratioing to background, 33
   removing label for, 49
   sensitivity for detecting, 40
   zooming in on, 17
Peak Page tab, 51
peak ratios, 33
peaks
   identifying
      automatically, 36
      manually, 43
   labeling, 48
   periodic table, 35
   history, 40
PHA status, 98
phase map
   copying, 80
Point & Shoot mode
   control file type, 83
   possible element, 37
power supply, 107
PowerPoint
   exporting report to, 79
   preparing for analysis, 35
Print command, 92
Print Preview command, 92
printing, 77
Processing tab, 41
project
   creating, 85
   creating template for, 88
   folder, 84
   importing file from, 87
   keywords, 91
   locking and unlocking, 88
   opening, 86
   properties, 86
   resetting, 90
Project Explorer, 85, 86, 91
commands, 18
Project Explorer command, 92
project template, 83
creating, 88
file type, 83
security, 88
projects, 83
Properties command, 61, 67, 93
Proza calibration factor, 71
psmsa file type, 83
psref file type, 83
pulse processor
status, 100

Q
Quant Analysis command, 60, 93
Quant Results tab, 62
Quantify Spectrum button, 58
quantitative analysis, 58
automatic, 42, 60
copying results of, 80
creating standard for, 66, 67, 69
excluding element from, 39
fit methods, 58
initial, 60
lines for, 38
manual, 61
preparing, 58
rerunning, 64
specifying results, 62
standard properties, 68
standard spectral data file type, 83
using results from in Excel, 81
using standards for, 73

R
ratioing
element, 65
peak to background, 33
rearranging toolbars, 97
ref file type, 83
region of interest
performing math operations on, 33
Region Tool tab, 33
removing
peak label, 49
toolbar, 97
renaming spectrum, 20
report
exporting to PowerPoint, 79
exporting to Word, 79
layout, 79
setting up, 77
reports, 77
rerunning quantitative analysis, 64
Reset Project command, 90, 93
Reset Spectrum button, 90, 93
resets, 100, 105
resetting
project, 90
spectrum size, 15
residual spectrum, 25
resizing
panes, 96
spectrum, 15
resolution
and detector, 98
PowerPoint report slide, 78
screen, 97
Restore Toolbars, 97
Restore Toolbars command, 93
restoring toolbars, 97
roaming user accounts, 95

S
Save button, 87
Save command, 87, 92
Save Map File command, 92
saving
diagnostic history, 102
rearranged screen, 97
screen resolution and color, 97
scrolling spectrum, 16
searching
database, 52, 55
database automatically, 42
for keywords, 91
for KLM lines, 50
on spectrum, 45
security for project template, 88
sensitivity
for identifying peaks, 40
si file type, 83
simcs file type, 83
siref file type, 83
sitif file type, 83
software
installing, 94
preparing to use, 6
starting, 6
spectra
automatic quantitative analysis of series of, 60
managing, 17
Spectra tab, 79
SpectraCheck, 27
Spectral Imaging
automation grid file type, 82
automation points file type, 82
chemical library file type, 82
NSS Spectral Analysis System Handbook 115
chemical type file type, 82
control file type, 82
element maps control file type, 83
external input map file type, 83
file type, 83
linescan control file type, 82
linescan reference image file type, 82
Point & Shoot reference image file type, 83
Point & Shoot spectral file type, 83
reference image file type, 83
rights for, 95
spectral match database file type, 83
standardless reference file type, 83
standards reference list file type, 83
video image file type, 83
WDS standards spectral data file type, 83
Spectral Match, 52
Spectral Match button, 56
spectrum
adding note text to, 20
background, 25
changing appearance of labels for peaks in, 51
comparing, 25
compressing, 16
copying, 80
displaying, 9
in entirety, 17
editing label for peak in, 48
expanding, 16
file type, 82
finding KLM lines on, 45
finding possible elements at peak in, 46
labeling all peaks in, 48
labeling peaks in, 48, 49
log scale, 17
moving, 15
normalizing, 26
opening, 18
overlaying, 79
properties for acquiring, 22
quantifying, 58
automatically, 60
manually, 61
removing label from peak in, 49
renaming, 20
requantifying, 64
residual, 25
resizing, 15
scrolling, 16
scrolling KLM lines on with arrow keys, 44
searching against database, 52, 55
synthetic, 25, 27
Spectrum Math, 28
Spectrum mode, 21
spectrum pane, 9
displaying energy cursor in, 51
Spectrum toolbar, 10
stage, 13
standard
creating, 66, 67, 69
name, 63
properties, 68
spectral data file type, 83
using for quantification, 73
standardless analysis, 71
Start Acquisition button, 14
starting software, 6
status bar
items to display in, 13
Status Bar command, 93
status LEDs, 104
std file type, 83
stn file type, 83
subtracting regions of interest, 33
synthetic spectrum, 25, 27
System Security command, 92
T
telephone numbers, 2
temperature
chassis, 101
detector, 101
template, 83
creating, 88
file type, 83
security, 88
temporary folder, 84
termination of spectrum acquisition, 23
tif file type, 83
TIFF files, 82
time constant, 24, 100
time limit for spectrum acquisition, 23
title
in report, 78
tnp file type, 83
toolbar
Acquisition, 10
Detector Selector, 11
Elements, 11
Ident, 11
moving, 97
NSS, 9
Spectrum, 10
toolbars, 9
rearranging, removing and restoring, 97
troubleshooting
resetting chassis for, 107
troubleshooting detector, 98
troubleshooting detector problems, 99
Undo command, 93
uninstalling software, 95
unlocking project, 90
user name in report, 78

validation error, 105
version number, 99
View menu commands, 93

warm detector, 105
WDS detector, 21
WDS elements
  acquiring, 23
web site, 2
weight
  error, 63
weight percentage, 62, 65
window
  panes, 7
Windows versions, 82
Word

exporting report to, 79
wstd file type, 83

XPhase
  map file type, 82
  spectrum file type, 82
x-ray image
  copying, 80
  file type, 82
x-ray lines
  energies and intensities, 46
  in quantitative analysis results, 62
x-ray map
  file type, 83

Z factor, 63
ZAF calibration factor, 71
ZAF factor, 63
zero histogram, 98
zero peak, 101
zooming in on peak, 17